To assemble this unit, please refer to the Installation Manual on pages 82 through 94.
Before operating this unit, please read these instructions completely. After reading them, keep them for future reference.
Because of the nature of the print film, all the printed text will remain on the film.
This product is designed for installation by a qualified servicing dealer. Installation performed by non-authorized individuals could cause safety-related problems with the operation of this equipment.
To locate the closest authorized dealer in your area, please call 1-800-449-8988.
Thank you for purchasing the Panasonic Electronic Print Board.
For optimum performance and safety, please read these instructions carefully.

Things you should keep a record of

Attach your sales receipt here

<table>
<thead>
<tr>
<th>For your future reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date of purchase</td>
</tr>
<tr>
<td>Serial number</td>
</tr>
<tr>
<td>Dealer's name and address</td>
</tr>
<tr>
<td>Dealer's telephone number</td>
</tr>
</tbody>
</table>

- Microsoft®, Windows®, Windows NT®, NetMeeting®, PowerPoint® and CalliGrapher® are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
  - Windows® is Microsoft® Windows® operating system.
  - Windows NT® is Microsoft® Windows NT® operating system.
  - NetMeeting® is Microsoft® NetMeeting® conferencing software.
  - PowerPoint® is Microsoft® PowerPoint® presentation graphics program.
- IBM® is a registered trademark of International Business Machines Corporation.
- Pentium® is a registered trademark of Intel Corporation in the U.S. and other countries.
- Adobe®, Acrobat® are registered trademarks of Adobe Systems Incorporated.
- All trademarks referred to in this manual are the property of their respective companies.

**Warning about saving data**
When the system storage device or any of its optional storage device is adversely effected by operational errors, static electricity, electrical noise, vibration, dust or when the power has been cut off due to malfunction, repair or inadvertently, the memory contents may be lost or changed. Before operating the system, make a point of reading the precautionary notes in the Operating Instructions and the help information, and observe them during operation.

**Please observe carefully the following precaution:**
- Make absolutely sure that all important data is saved by back-up or the original is saved.

The manufacturer hereby declares that it cannot be held accountable for any loss or change in any data stored on floppy disks, hard disks, optical disks, or other memory devices.
Warning Notices

**WARNING:**
TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THIS PRODUCT TO RAIN OR ANY TYPE OF MOISTURE.

**CAUTION:**
TO PREVENT RISK OF ELECTRIC SHOCK HAZARD, DO NOT REMOVE THE COVER OF THIS PRODUCT, REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

THE SOCKET-OUTLET MUST BE NEAR THIS EQUIPMENT AND MUST BE EASILY ACCESSIBLE.

Federal Communications Commission Requirements

**Note:** This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

**FCC Warning:** To assure continued FCC compliance, the user must use only the provided power supply cord. Also, any unauthorized changes or modifications to this equipment would void the user’s warranty.

**NOTICE:** This product has a fluorescent lamp that contains a small amount of mercury. It also contains lead in some components. Disposal of these materials may be regulated in your community due to environmental considerations. For disposal or recycling information please contact your local authorities, or the Electronics Industries Alliance: <http://www.eiae.org>.

Accessories

- Film cassette (Blue gear×1, Green gears×3) ………1
- Thermal transfer film [20m (65.6’)] …………………1
- Markers (Black, Red, Blue–Big) …………… Each 1
- Eraser ……………………………………………………………1
- Letter papers …………………………………………………20 sheets
- Pen holder …………………………………………………2
- Markers for interactive 
  (Black, Red, Blue, Green–Small) …………… Each 1
- Electronic eraser …………………………………………1
- Eraser cloth (for Electronic eraser) …………………2
- Batteries (LR03 “AAA”) ……………………………………6
- Power cord …………………………………………………….1
- Interactive cable [5m (16.4’)] ……………………1
- Software CD-ROM ……………………………………….1
- Operating Instructions ……………………………………1
- Software License Agreement ……………………1
- Wall-mounting template ……………………………1
- Warranty card …………………………………………….1

*The markers (Big) and the eraser are used for other than the interactive function.
*The markers for interactive (Small) are used while inserted in the pen holder.

In this manual, the pen holder with a marker for interactive (Small) is called the Electronic Pen.
The Electronic Pen and the Electronic Eraser are used with the interactive function.
Features

The KX-BP800 is equipped with two interactive functions; Projector mode and Whiteboard mode, in addition to a regular electronic print board that utilizes plain paper. It is possible to use this product as follows.

● Electronic print board

Functions

● Allows copying up to 9 copies per screen
● Allows printing in 2 level contrast (Normal/Dark)
● Allows printing of 2-screens at the time by compressing them into a single sheet of paper

● Projector mode (Interactive function)

Connect the Interactive Panaboard to a computer that is connected to a projector and use the projector to project the image onto the Interactive Panaboard. This is called the Projector mode. In this mode, the following operations are possible:

● Operating the computer using the Electronic Pen with its cap on as a mouse
● Drawing handwritten lines or erasing it using the Electronic Pen with its cap on in the projected image
● Saving the projected image to an image file and printing the projected image
● Recording the operations of drawing and erasing handwritten lines, playing back and editing the recorded operations later

In Projector mode, the projected computer image on the screen of the Interactive Panaboard can be operated by using the Electronic Pen as a mouse. You can execute the application and electronically write or erase notes. The electronically handwritten or partially erased computer image can be stored into an image file. This will help make your presentation more impressive to the attendants.
● Whiteboard mode (Interactive function)

By connecting the Interactive Panaboard to a computer, the information written on the Interactive Panaboard is displayed on the computer in real-time.

This is called the Whiteboard mode.

In this mode, the following operations are possible:

- The information written on the Interactive Panaboard using the Electronic Pen with its cap off will be displayed on the computer screen at the same time.
- The information erased using the Electronic Eraser will be erased in the computer as well.
- You can save drawings and notes into a file which can later be printed.
- Allows the user to record the information being written or erased in a file that can be played back as a movie and it can be edited if needed.

● PC Interface (Option)

When the optional PC Interface Kit (KX-BP095) is used, you can scan monochrome images from the KX-BP800 into a computer running Microsoft® Windows® or Windows NT® and print documents on the computer to the printer of the KX-BP800.

For the operation using the PC Interface Kit, please refer to the Operating Instructions of the PC Interface Kit (KX-BP095).
# Table of Contents

### Before you start

**Precautions** ................................................................. 8

**Part Names and Functions** ............................................ 12
  - The control panel ......................................................... 13

### Using

**Installing Thermal Transfer Film** ................................. 14

**Loading Copy Paper** .................................................... 16

**Making Copies** ............................................................ 18
  - Copy types and procedures ............................................. 19

**Replacing Thermal Transfer Film** ................................. 20

**Paper Jams** .................................................................. 21

**Before Using the Interactive Function** .......................... 24
  - Setting the Electronic Pen ............................................ 24
  - Setting the Electronic Eraser ....................................... 25
  - Replacing the eraser cloth ........................................... 25
  - System requirements .................................................. 26
  - Connecting to the PC .................................................. 26
  - Installing the software ............................................... 27
    - Uninstalling the software .......................................... 27

**Using the Interactive Panaboard Software** ...................... 29
  - Start up the Interactive Panaboard Software .................. 29
  - Pop-up menu configuration of the Interactive Panaboard Software ................................................. 30
  - Switching the mode .................................................... 30
  - Settings of the Interactive Panaboard Software .......... 31
  - Reference the help ...................................................... 33
  - Display the information about the Interactive Panaboard Software ................................................. 33
  - Exiting the Interactive Panaboard Software .................. 33

**Projector Mode** ............................................................ 34
  - Precautions when using a projector ............................... 34
  - Basic operation flow in Projector mode ....................... 35
  - About Desktop Drawing Tool ...................................... 39
  - Desktop Drawing Tool operation ................................. 40
  - About On-Screen Keyboard ........................................ 47
  - On-Screen Keyboard operation .................................... 47
  - About View window ................................................... 50
### Table of Contents

#### Using

- Whiteboard Mode ................................................................. 51
  - Basic operation flow in Whiteboard mode ......................... 51
  - About Whiteboard window .............................................. 53

- View Window or Whiteboard Window Operation .............. 54
  - Differences between the View window and the Whiteboard window ........................................ 54
  - Menu configuration ......................................................... 54
  - Tool bars ........................................................................ 57
  - Create an IPB document (Whiteboard window only) .......... 58
  - Open an IPB document .................................................... 58
  - Save the IPB document .................................................... 58
  - Save the IPB document in another file format ................ 59
  - Change display method ................................................... 62
  - Switch a page of the IPB document .................................. 62
  - Edit a page of the IPB document ...................................... 63
  - Playback the IPB document ............................................. 66
  - Recognizing Handwriting in the IPB document ................ 66
  - Print the IPB document .................................................... 68
  - Settings ........................................................................... 69

- Remote Conferencing Using Microsoft® NetMeeting® .... 73
  - About NetMeeting® ......................................................... 73
  - Example of using NetMeeting® ........................................ 73

#### Help

- Daily Care and Maintenance ............................................ 75

- Troubleshooting ............................................................... 77
  - Meanings of various displays .......................................... 79

- Specifications .................................................................... 80
  - Consumable and accessories ......................................... 81

#### Installation

- Installation Manual ......................................................... 82

*The IPB document is a Interactive Panaboard format file (extension ".ipb").
Precautions

Never remove the cover, or take apart or modify the product. This will void the warranty.

Do not position the electronic print board in a location where it is not stable.

Do not put drinks or other liquids on the tray.

After installing or moving the electronic print board, lock the casters and set the fall-prevention extension legs.

Do not use the electronic print board in an excessively humid or dusty location.

If the electronic print board is not going to be used for an extended period of time (e.g., during extended holidays), turn off the power and remove the plug from the wall outlet.
### Precautions

<table>
<thead>
<tr>
<th><strong>Installation</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>● Do not install the unit where it may be exposed to direct sunlight, near heating</td>
</tr>
<tr>
<td>equipment, or near air-conditioning vents as this may cause stretching and/or</td>
</tr>
<tr>
<td>discoloration of the screen.</td>
</tr>
<tr>
<td>● Do not install the unit in locations having a temperature of 10°C (50°F) or</td>
</tr>
<tr>
<td>lower or where the temperature may change suddenly as this may disable the unit’s</td>
</tr>
<tr>
<td>ability to make copies.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Screen film</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>● Make thick and dark lines inside the copying area. Note that any writing inside the</td>
</tr>
<tr>
<td>shaded area on the right figure cannot be copied.</td>
</tr>
<tr>
<td><img src="image" alt="Screen film diagram" /></td>
</tr>
<tr>
<td>● Use a commercially available white board cleaner for hard-to-erase stains.</td>
</tr>
<tr>
<td>(SANFORD® EXPO® white board cleaner etc.)</td>
</tr>
<tr>
<td>● Do not erase with an overly dirty eraser. (See pages 75 and 77.)</td>
</tr>
<tr>
<td>● Do not allow writing to remain on the screen for an extended period of time as it</td>
</tr>
<tr>
<td>will become harder to erase.</td>
</tr>
<tr>
<td>● Periodically wipe the screen film gently with a water-dampened cloth that has</td>
</tr>
<tr>
<td>been thoroughly wrung. (See page 75.)</td>
</tr>
<tr>
<td>● Do not touch the screen, write with markers, or erase while the screen is moving</td>
</tr>
<tr>
<td>as this may result in damage to the unit.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Markers, Erasers and Thermal transfer film</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>● Use only the included or designated markers, erasers and thermal transfer film.</td>
</tr>
<tr>
<td>(See page 81.)</td>
</tr>
<tr>
<td>Use of accessories other than those included or designated (such as oil-based</td>
</tr>
<tr>
<td>markers) may damage the screen or result in hard-to-erase markings.</td>
</tr>
<tr>
<td>● Copy quality increases with the thickness of the drawn line. To ensure quality</td>
</tr>
<tr>
<td>copies, please use the markers (Big).</td>
</tr>
<tr>
<td>● The markers for interactive (Small) draw thin lines. The quality of the copies may</td>
</tr>
<tr>
<td>be reduced when these markers are used.</td>
</tr>
<tr>
<td>● Do not store the thermal transfer film in a location subject to extreme changes in</td>
</tr>
<tr>
<td>temperature (such as near air conditioning or heating equipment) as this may</td>
</tr>
<tr>
<td>cause condensation on the thermal transfer film and result in poor print quality</td>
</tr>
<tr>
<td>and/or paper jams.</td>
</tr>
<tr>
<td>● Store markers horizontally as vertical storage may stop the ink from coming out.</td>
</tr>
<tr>
<td>● The length of one roll of designated thermal transfer film (Replacement film : KX-</td>
</tr>
<tr>
<td>BP081 or KX-BP082) is approximately 100 meters (328.1’). One roll of thermal</td>
</tr>
<tr>
<td>transfer film can make approximately 300 sheets of copies. Note that the total number of copies may differ depending on the operating conditions. Also note that the length of the thermal transfer film supplied with the unit is shorter than the replacement film roll and is only approximately 20 meters (65.6’).</td>
</tr>
</tbody>
</table>

SANFORD® and EXPO® are registered trademarks of Sanford corporation.
<table>
<thead>
<tr>
<th>Precautions</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power cord and Interactive cable</strong></td>
<td>- Before moving the unit, disconnect the power cord from the electrical power socket and AC inlet, and disconnect the interactive cable from the interactive connector and a PC. Then coil them for transportation. Failure to do these cause the cord and cable to be damaged if they are stepped on or if they catch on something while the unit is being moved.</td>
</tr>
</tbody>
</table>
| **Replacing the Thermal transfer film** | - Dispose of the used thermal transfer film in a trash receptacle for burnable trash.  
- A negative of the copied image will remain on the thermal transfer film.  
(To protect the security of your information, we recommend cutting up used thermal transfer film with scissors or shredder before disposing of it.) |
| **Electronic Pen and Electronic Eraser** | - Do not cover the transmitter with your hand while using an interactive function as this may cause the position of the Electronic Pen or the Electronic Eraser not to be normally detected.  

![Transmitter](image)  

- Press down firmly with the point of the Electronic Pen or the eraser cloth of the Electronic Eraser on the screen film until you hear a buzzing sound, and then move it slowly.  
However, do not press down the point of the Electronic Pen too much strongly as this may make a dent in the screen back panel.  
- Do not use two or more the Electronic Pens or the Electronic Eraser at the same time as this may cause the position of the Electronic Pen or the Electronic Eraser not to be normally detected.  
- For precise positioning, keep the Electronic Pen and Electronic Eraser perpendicularly to the screen during use.  
- Since ultrasonic is used to detect the position of the Electronic Pen and Electronic Eraser when they are being used, you may hear a buzzing sound, but this is not harmful to the human body or peripheral hardware.  
It will also not result in an electric shock. |
### Battery

<table>
<thead>
<tr>
<th>Precautions</th>
</tr>
</thead>
<tbody>
<tr>
<td>If batteries are used improperly, batteries may leak, causing corrosion of the product, or they may burst. To prevent this, always follow the precautions given below.</td>
</tr>
<tr>
<td>● Always remove batteries from the Electronic Pen and Electronic Eraser if they are not to be used for an extended period of time.</td>
</tr>
<tr>
<td>● Use the same type of batteries. Do not mix different types.</td>
</tr>
<tr>
<td>● Do not mix old and new batteries.</td>
</tr>
<tr>
<td>● Always insert batteries with their polarity properly oriented as indicated on the Electronic Pen or Electronic Eraser.</td>
</tr>
<tr>
<td>● If the Electronic Pen or Electronic Eraser ceases to function because batteries have run out, remove them immediately and dispose of them according to local regulations.</td>
</tr>
<tr>
<td>Leaving drained batteries in the Electronic Pen or Electronic Eraser may result in leakage.</td>
</tr>
<tr>
<td>● Do not disassemble batteries or place them in a fire.</td>
</tr>
<tr>
<td>● Do not short batteries.</td>
</tr>
<tr>
<td>● Alkaline batteries cannot be recharged. Never attempt to recharge alkaline batteries.</td>
</tr>
</tbody>
</table>

### Projector

<table>
<thead>
<tr>
<th>Precautions</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Light from the projector may enter the eye when using a projector to project images for the purpose of making presentations and so on. Be very careful as direct projector light may hurt the eyes.</td>
</tr>
</tbody>
</table>
Part Names and Functions

Electronic Pen/Electronic Eraser Position Receiver

Power Switch

Output Port
Outputs copy paper that has been copied. Can hold up to 20 sheets.

Paper Cover
Open this cover when loading copy paper.

Printer Door
Open the printer door when loading transfer film or when removing paper jams. (See pages 14, 20 and 21.)

Control Panel

1. Contrast/Remaining Film Indicator
2. Contrast Key
3. 2-Screen Copy Key
4. Copy Key
5. Multi-Copy/Error Indicator
6. Multi-Copy/Stop Key
7. Advance Key

Electronic Pen (See page 24)

*When using the projector mode to operate the computer screen on the print board screen and operating the pen while holding down the pen button achieves the same function as pressing the right mouse button.

Electronic Eraser (See page 25)
## Part Names and Functions

### The control panel

<table>
<thead>
<tr>
<th>Name</th>
<th>Panel</th>
<th>Description</th>
</tr>
</thead>
</table>
| **① Contrast/Remaining Film Indicator** | ![Contrast Indicator](image) | This lamp indicator notifies the user when the time to replace the thermal transfer film is approaching (estimated) and of the printing contrast used during copying.  
Indicator off: Normal printing contrast.  
Indicator on: Darker than normal printing contrast.  
Indicator flashing: Almost time to replace the thermal transfer film.  
(Not that only about 15 more sheets may be copied when this indicator starts flashing.)  
Replacement film (KX-BP081 or KX-BP082) is separately available from the dealer where you purchased your unit.  
*The flashing indicator will go out after the power is turned off and the printer has been opened and closed. (When copying is performed, this indicator will begin flashing again.)* |
| **② Contrast Key** | ![Contrast Key](image) | Each time this key is pressed, the unit will alternate between normal and dark contrast modes (Normal/Dark). |
| **③ 2-Screen Copy Key** | ![2-Screen Key](image) | This key causes the front and back of the screen to be copied on a single sheet of paper. |
| **④ Copy Key** | ![Copy Key](image) | This key prints a copy of the screen. |
| **⑤ Multi-Copy/Error Indicator** | ![Multi-Copy Indicator](image) | This indicator displays the number of copies to be made. The display changes each time the multi-copy/stop key is pressed.  
Example: 1 → 2 → ⋮ → 9 → 1 → ⋮  
When an error occurs, a flashing symbol will appear in this display to indicate the error status. (See page 79.) |
| **⑥ Multi-Copy/Stop Key** | ![Multi-Copy Key](image) | When making multiple copies, press this key until the desired number of copies is displayed on the multi-copy/error indicator. This key can also be pressed while multiple copies are being made to stop the copying process. The display indication changes while multiple copies are being made as shown below. After reaching 0, the display will reset to 1.  
Example: 5 → 4 → 3 → 2 → 1 → 0 → 1 (countdown display during copying) |
| **⑦ Advance Key** | ![Advance Key](image) | This key advances the screen from right to left. |
Installing Thermal Transfer Film

Load the thermal transfer film into the film cassette and install in the printer.

1. Set the power switch to on (| ).
   - “ ▴ ” will flash on the multi-copy/error indicator when the thermal transfer film has run out.

2. Push down the printer open lever and open the printer door.

3. Insert the four gears into the new thermal transfer film.
   - Securely align the gear tabs with the grooves in the thermal transfer film and insert them as far as they will go.

   Note
   - There is a blue gear and three green gears which need to be attached as shown in the figure on the right."
4 Load the thermal transfer film into the film cassette.

- Load the thermal transfer film into the film cassette so that the blue gear inserted in the thermal transfer film is located on the blue label side of the film cassette. Push in the direction of the arrow until you hear all four gear shafts click in place.

5 If the thermal transfer film is slack, take up the slack by winding the gears on the label side of the cassette in the direction of the arrows.

- The multi-copy/error indicator may flash " \( \text{ } \) " if the thermal transfer film is slack. In addition, the thermal transfer film may wrinkle, and blank (unprinted) spots or black streaks may appear on the copy paper.

6 Install the film cassette.

- Insert the film cassette into the printer so that the blue gear on the cassette aligns with the blue label on the printer and then insert the gear shafts on both sides of the cassette into the grooves inside the printer.
- If the film is slack after loading the film cassette, take up the slack in the same manner described in step 5 while the cassette remains loaded.

7 Close the printer door.

- Securely close the printer door by using both hands until a click is heard.
- The " \( \text{ } \) " flashing on the multi-copy/error indicator will go out.

Note

- If the flashing " \( \text{ } \) " does not go out even though the printer door has been closed, this indicates that the film cassette has not been installed properly or that there is slack in the thermal transfer film. Check the condition of the film cassette and for slack in the thermal transfer film.
Loading Copy Paper

It is possible to load up to 80 sheets of Letter size copy paper [assuming a paper weight of 80g/m² (21 lbs)]. Note that only Letter paper may be used.

When the unit is first used or when " ☐ " flashes on the multi-copy/error indicator to indicate that the unit is out of paper, load copy paper as described below.

Notes on Loading Copy Paper

Follow the guidelines below to ensure smooth and accurate printing by the unit.

- Only use Letter size copying paper having a weight of 60 to 90g/m² (16 to 24 lbs) as the copy paper for this unit.
- Do not simultaneously load paper of varying type and thickness as this may result in paper jams.
- Before adding copy paper, be sure to remove all copy paper remaining inside the unit’s paper cover. (Note: That copy paper will slightly resist being removed, but may be pulled out without problems.) After removing the copy paper, stack the removed paper together with the new paper, fan it thoroughly, square it and reload.

DO NOT USE THE FOLLOWING TYPES OF PAPER

- Extremely smooth or glossy paper
- Coated paper
- Thermal paper
- Paper that is printed on one side
- Wrinkled paper, creased paper, etc.

1 Set the power switch to on ( )

- " ☐ " will flash on the multi-copy/error indicator when copy paper has run out.

Note

- Be absolutely sure to check that the power is on when loading copy paper as it will not load properly otherwise.

Power Switch
Loading Copy Paper

2 Pull the paper cover forward as shown in the right figure.

**Note**
- The magnets are used as fasteners to hold the paper cover closed.

3 To prevent paper jams such as those caused by multiple sheets feeding, once fan the paper thoroughly, square it, align it with the guide inside, and insert as far as it will go.

**Note**
- Only use Letter size copying paper having a weight of 60 to 90g/m² (16 to 24 lbs) as the copy paper for this unit.
- Do not stack more copy paper in the unit than the maximum paper limit indicated by the guide (see figure to the right) as this may result in paper jams. [The unit can hold about 80 sheets of paper having a weight of 80g/m² (21 lbs).]

4 Close the paper cover.
Making Copies

This section describes how to copy text and illustrations drawn on the screen.

1 Set the power switch to on ( | ).
   • "1" will light on the multi-copy/error indicator to indicate that the unit is ready to copy.

2 Press the copy key ( ).
   • Text and illustrations on the screen will be copied and copies emerge from the output port.
   • The output port can hold up to 20 sheets of copy paper. (Note that exceeding the output port’s capacity may result in paper jams.)
   • For details on making multiple copies, 2-screen copies and so on, see page 19.

Note

• Do not use paper that has been copied on one side by this printer as copy paper in this unit or in any other copiers or printers as this may result in dirty rollers, degradation of printing quality, paper jams, and streaks and smudges on output paper.
• Copy quality increases with the thickness of the drawn line. To ensure quality copies, please use the markers (Big).
• The markers for interactive (Small) draw thin lines. The quality of the copies may be reduced when these markers are used.
## Copy types and procedures

<table>
<thead>
<tr>
<th>Copy Type</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copying the front of the screen</td>
<td>Press †</td>
</tr>
<tr>
<td>Copying the back of the screen</td>
<td>① Press † to move the screen to be copied to the front.  ② Press †</td>
</tr>
<tr>
<td>Making multiple copies (up to 9)</td>
<td>① Select the number of copies (1 to 9) by pressing † as necessary.  ② Press †</td>
</tr>
<tr>
<td></td>
<td>● Press † to stop copying in mid-operation.</td>
</tr>
<tr>
<td>Making 2-screen copies</td>
<td>Press †</td>
</tr>
<tr>
<td>Chart paper</td>
<td>Chart paper can be attached to the screen as shown in the figure and copied. (Be sure to take the chart off the screen soon after copying is finished.)</td>
</tr>
<tr>
<td>Copying chart paper</td>
<td>● Wrinkles, slackness or folds in the chart when attached to the screen will show up in copies as dark shadows.  ● Affix it to the screen with drafting tape made by 3M® or other similar tape with medium adhesive.</td>
</tr>
</tbody>
</table>

3M® is a registered trademark of 3M Corporation.
Replacing Thermal Transfer Film

The unit is capable of producing about 15 more copies when the contrast/remaining film indicator begins to flash. The unit has run out of thermal transfer film and can no longer make copies when the multi-copy/error indicator flashes “.”. Separately available replacement film (KX-BP081 or KX-BP082) may be purchased from the dealer where you purchased the unit. Thermal transfer film is replaced as follows.

**Notes on Replacing Thermal Transfer Film**

- Only use the designated product (KX-BP081 or KX-BP082) from Panasonic as the replacement film. (Note that using another type of replacement film may result in degraded printing quality or damage to the unit.)

- Thermal transfer film is disposable. Dispose of used thermal transfer film as "burnable" or "non-recyclable" rubbish.

- A negative of the copied image will remain on the thermal transfer film. To protect the security of your information, we recommend cutting up used thermal transfer film with scissors or shredder before disposing of it.

1. Push down the printer open lever to open the printer door, and remove the film cassette with both hands.

2. Remove the used thermal transfer film from the film cassette and remove the four gears.

3. Next, perform steps 3 to 7 in the section entitled "Installing Thermal Transfer Film" that can be found on page 14 and 15.
Paper Jams

Remove paper jams by the following procedure when copy paper does not come out of the output port or when "J" flashes on the multi-copy/error indicator.

1. Push down the printer open lever to open the printer door.

2. Remove the film cassette with both hands.

3. Remove all jammed paper.

4. If the thermal transfer film is slack, take up the slack by winding the gears on the label side of the cassette in the direction of the arrows.
   - The multi-copy/error indicator may flash "J" if the thermal transfer film is slack. In addition, the thermal transfer film may wrinkle, and blank (unprinted) spots or black streaks may appear on the copy paper.
5 Install the film cassette.
- Insert the film cassette into the printer so that the blue gear on the cassette aligns with the blue label on the printer and then insert the gear shafts on both sides of the cassette into the grooves inside the printer.

6 Close the printer door.
- Securely close the printer door with both hands until a click is heard.
- The " ⤷ " flashing on the multi-copy/error indicator will go out.

If the flashing " ⤷ " does not go out after the foregoing procedure has been performed;
This may indicate that the paper feeder is not functioning properly.
Reload the copy paper by following the steps given below.

1 Turn the power off and on.

2 Open the paper cover and remove all copy paper remaining inside the unit's paper cover.
- Note that the copy paper will slightly resist being removed, but may be pulled out without problems.
3 To prevent paper jams such as those caused by multiple sheets feeding, once fan the paper thoroughly, square it, align it with the guide inside, and insert as far as it will go.

Note
- Do not stack more copy paper in the unit than the maximum paper limit indicated by the guide (see figure to the right) as this may result in paper jams. [Note that the unit can hold about 80 sheets of paper having a weight of 80g/m² (21 lbs).]

4 Close the paper cover.
Before Using the Interactive Function

Setting the Electronic Pen

1. Remove the battery cover on the pen holder, insert the batteries as shown in the figure to the right, and re-attach the battery cover.
   - Always use “AAA” size (alkaline) batteries and be sure that their polarity is properly oriented.
   - Do not mix old and new, different type batteries when replacing batteries.

2. Remove the temporal cap, and set the cap and adaptor to the marker for interactive.
   - Securely push the adaptor into the maker for interactive as far as it will go.
   - Do not remove the color identification cap on the back end of the marker.

3. Rotate the pen holder lever to the release position, insert the marker for interactive, and then return the pen holder lever to the lock position.
   - Lock the pen holder lever while inserting the marker all the way into the pen holder until you hear a buzzing sound. Detection of the marker color may not work well unless the marker is inserted fully into the pen holder.
   - Do not set the marker near the electronic print board while using the interactive function as this may appear unnecessary streaks not written on the computer screen.

Note

- Press down firmly with the point of the Electronic Pen on the screen film until you hear a buzzing sound.
- For precise positioning, keep the Electronic Pen perpendicularly to the screen during use. Inclined pen angle will cause the shift of position.
Before Using the Interactive Function

■ Setting the Electronic Eraser

Remove the eraser cover, insert the batteries as shown in the figure to the right, and re-attach the eraser cover.

- Always use “AAA” size (alkaline) batteries and be sure that their polarity is properly oriented.
- Do not mix old and new, different type batteries when replacing batteries.

■ Replacing the eraser cloth

1. Remove the eraser cloth by pushing through the hole in the Electronic Eraser.

2. Attach a new eraser cloth by pressing around the edge.

Note

- Press down firmly with the eraser cloth of the Electronic Eraser on the screen film until you hear a buzzing sound.
Before Using the Interactive Function

### System requirements

- **Computer:** IBM® PC/AT or compatible machine with CD-ROM drive
- **CPU:** Pentium® 150MHz or higher processor
- **Port:** 9-pin communication (COM) port
- **Memory:** 32MB or higher
- **Hard Disk Space:** At least 10MB free space

### Connecting to the PC

1. Connect one end of the proprietary interactive cable supplied to the interactive connector under the tray and the other end to the computer's communication (COM) port.

   **Note**
   - Be sure to turn off the electronic print board and PC before you connect or take off the interactive cable.

2. After connecting the interactive cable, securely tighten the screws on the connector.

   **Note**
   - This cable is a proprietary interactive cable for connecting the electronic print board with a PC. Please do not use it with any other products.
Before Using the Interactive Function

Installing the software

In order to use interactive functions by connecting a computer and the Interactive Panaboard, it is necessary to install the Interactive Panaboard Software.

When you insert the CD-ROM into the CD-ROM drive, the Installation Software will run automatically. This will display the software menu on the right. This menu consists of two sub menus;

Manuals

- Readme - You can view the readme file
- Operating Instructions – **You can view the Operating Instruction Manual.

Applications

- Interactive Panaboard – This install the software needed for the Interactive Panaboard.

*Depending on the Operating System or the settings that you are using, the Automatic Installation Software may not work. If this is the case please run the Installation Software "cdrun.exe” in the CD-ROM through Windows Explorer.

**Install Acrobat Reader 4.0 – Acrobat Reader is needed in order to view the Operating Instruction Manual.

Remark:

- Logon as the administrator when using Windows NT® 4.0, Windows® 2000 or Windows® XP.

Installing the Interactive Panaboard Software

(1) Click “Interactive Panaboard” from software menu.

- Installation of the Interactive Panaboard Software will start.

(2) Follow the instructions on the screen to complete the installation.

- When the installation of the Interactive Panaboard Software is completed, “Interactive Panaboard” group will be entered under “Panasonic” at the Program menu.

Under the “Interactive Panaboard” group, there will be three items, Interactive Panaboard Software, Help and Operating Instructions.

- Adobe® Acrobat® Reader is necessary to refer to the Operating Instructions.

Remark:

Uninstalling the software

If you need to uninstall the Interactive Panaboard Software, please follow the following procedure.

(1) Click the [Start] button, and then click "Control Panel" in "Settings".

(For Windows® XP, click the [Start] button, and then click "Control Panel".)

(2) Double-click "Add/Remove Programs" icon in the Control Panel.

(3) Select "Interactive Panaboard" in the Add/Remove Programs list, and click [Add/Remove] button.

(4) Follow the instructions on the screen to complete the uninstall.
Before Using the Interactive Function

● In order to view the Operating Instruction Manual on the CD-ROM, Reference of the Interactive Panaboard Operating Instructions in CD-ROM

   ● Adobe® Acrobat® Reader is necessary to refer to the Operating Instructions.
   ● If it is not installed on your computer, install Adobe® Acrobat® Reader before refer to the Operating Instructions.

   (1) Click "Operating Instructions" in Manuals group of the Automatic Installation Software.

   (2) You can see the Operating Instructions after Adobe® Acrobat® Reader runs automatically.

● Installing Adobe® Acrobat® Reader

   (1) Click "Acrobat (R) Reader" in Manuals group of the Automatic Installation Software.
   ● Installation of Adobe® Acrobat® Reader will start.

   (2) Follow the instructions on the screen to complete the installation.
Using the Interactive Panaboard Software

Start up the Interactive Panaboard Software

1. Turn on the power of the Interactive Panaboard.

2. Turn on the computer’s power and start up Windows.

3. Click the [Start] button, and then click [Programs] · [Panasonic] · [Interactive Panaboard] · [Interactive Panaboard].
   (For Windows® XP, [All Programs] instead of [Programs])
   • The Interactive Panaboard Software runs, and the COM detection dialog box appears to show the Interactive Panaboard is detected.

4. Click the [OK] button.
   • The Select Mode dialog box will appear.

5. Click either the [Projector] button or the [Whiteboard] button, and then click the [OK] button.

When the Projector mode is selected:

- The calibration start screen will be displayed, then calibrate to adjust the position of the projected image and the position of the Interactive Panaboard screen.
- When the calibration is completed and the Projector mode become active, the icon will be registered in the Taskbar and the Desktop Drawing Tool will appear automatically.
  • In the Projector mode, the Desktop Drawing Tool is used for operation.
  • The View window is used for playback and for editing a file which is recorded in the Projector mode.
  • For operation of the Projector mode, refer to “Projector Mode” from page 34.

When the Whiteboard mode is selected:

- The icon will be registered in the Taskbar and the Whiteboard window will appear automatically.
  • In the Whiteboard mode, the contents of the drawing on the Interactive Panaboard Screen will be displayed in the Whiteboard window.
  • The Whiteboard window is also used to playback and to edit a file which is recorded in the Whiteboard mode.
  • For operation of the Whiteboard mode, refer to “Whiteboard Mode” from page 51.

Remark:

- If the Interactive Panaboard is not detected, the notification dialog box appears.
  In this case, check the status of the Interactive Panaboard and confirm that the interactive cable is connected. For details on the settings of the communications (COM) port, refer to “COM port” on page 31.
- If the Interactive Panaboard Software is used without connecting the Interactive Panaboard, click [Offline] button in the notification dialog box.
  In the offline state, a file recorded in the Projector mode or the Whiteboard mode can be played back and edited.
- The tool tip text displayed when the mouse is located over the icon in the Taskbar allows you to determine the current mode.
  Projector mode: "Interactive Panaboard (Projector)"
  Whiteboard mode: "Interactive Panaboard (Whiteboard)"
Using the Interactive Panaboard Software

■ Pop-up menu configuration of the Interactive Panaboard Software

Right-click the in the Taskbar to get the pop-up menu. Following operations are possible in the pop-up menu.

- **Select Mode...** : Allow you to switch between modes (Projector mode/ Whiteboard mode).
- **Calibrate** : Execute the calibration. (Projector mode only) ➔ Page 35
- **Tool**
  - **Draw** : Display the Desktop Drawing Tool. (Projector mode only) ➔ Page 39
  - **On-Screen Keyboard** : Display the On-Screen Keyboard. (Projector mode only) ➔ Page 47
  - **View Window** : Display the View window. (Projector mode only) ➔ Page 50
- **Open/Close Whiteboard window** : Switch the Whiteboard window open/close. (Whiteboard mode only) ➔ Page 53
- **Settings**
  - **COM Port...** : Set the communication port.
  - **Adjustment...** : Adjust the position of the Electronic Pen or the Electronic Eraser to improve the shifted position.
  - **Options...** : Set the option of the Interactive Panaboard Software.
- **Help Topics...** : Display the help of the Interactive Panaboard Software.
- **About...** : Display the Interactive Panaboard Software version information.
- **Exit** : Exit the Interactive Panaboard Software.

■ Switching the mode

You can freely switch the Projector mode and the Whiteboard mode while the Interactive Panaboard Software is running.

1. Right-click the icon in the Taskbar and click [Select Mode...] in the pop-up menu. In addition, you can double-click the icon in the Taskbar.
   - The Select Mode dialog box will appear.

2. Click either the [Projector] button or the [Whiteboard] button, and then click the [OK] button.
   - When switching to the Projector mode, the calibration screen will not be displayed automatically after calibration ended correctly once. Please calibrate if necessary.
   - When switching to the Whiteboard mode, the Whiteboard window will be displayed.
Using the Interactive Panaboard Software

■ Settings of the Interactive Panaboard Software

• COM port
  Setup the communication port to communicate with the Interactive Panaboard.

  1. Right-click the icon in the Taskbar and click [Settings] · [COM port...] in the pop-up menu.
  • The COM port dialog box will appear.

  2. Click the [Start...] button of the Auto Detection to detect the communication port connected with the Interactive Panaboard automatically. Otherwise, click the arrow at the bottom on the right side of the [COM port] box and then click the communication port from the list.

  3. Click the [OK] button.

• Adjustment
  The Electronic Pen or the Electronic Eraser position may largely shift by the using environment. In this case, adjust the position according to the following procedures to improve the shifted position.

  1. Right-click the icon in the Taskbar and click [Settings] · [Adjustment...] in the pop-up menu.
  • The Adjustment dialog box will appear.

  2. Place the Electronic Pen at the center of the Interactive Panaboard screen and drag slowly the Electronic Pen downward about 100mm (4").
  • When the adjustment is finished, the adjustment end message will be displayed in the Adjustment dialog box and the [Cancel] button will be changed into the [OK] button.

  3. Click the [OK] button.

Note

• For precise adjusting, keep the Electronic Pen perpendicularly to the Interactive Panaboard screen during the adjustment. Inclined pen angle will cause the shift of position.
• To cancel the adjustment, click the [Cancel] button by a mouse of the computer.
Using the Interactive Panaboard Software

● Options

Set-up the option of the Interactive Panaboard Software.

1) Right-click the icon in the Taskbar and click [Settings] · [Options...] in the pop-up menu.

The Options dialog box will appear.

2) The following options can be set.

Show Desktop Drawing Tool when Projector Mode starts:
When this is selected, the Desktop Drawing Tool is automatically displayed after the Projector mode starts.

Print out image automatically rotates to fit printer paper direction:
When this is selected, the printing image automatically rotates to fit the direction of paper set in a printer.

[On-Screen Keyboard] group
This sets whether the original keyboard or Windows keyboard is to be used.
Original Keyboard: The original keyboard of the Interactive Panaboard Software is used.
Windows Keyboard: The On-Screen Keyboard provided with Windows is used.
* Windows Keyboard can be used only with Windows® Millennium Edition, Windows® 2000 or Windows® XP.

[Desktop Drawing Tool: Capture] group
JPEG : To set the quality level when exporting a page as a JPEG format image file.
TIFF : To perform compression when exporting a page as a TIFF format image file, select (turn ON) the [Compression (PACKBITS)] check box.
Save file automatically, named with the date: When this check box is selected, the image file will be saved automatically as a file named with the date of capture.
Save folder: Sets the default folder for saving image files.
File Format: Sets the default format for saving image files.
Display save verification dialog box: Select this check box to display a dialog box to verify the image file name.

[Desktop Drawing Tool: Recording Method] group
Sets the recording method when recording marker and eraser data as an IPB document in Projector mode.

Select [(Method 1) Draw strokes and record after verifying the background image] to verify the background image before recording the marker and eraser data that is drawn.
Select [(Method 2) Record strokes and background image together] to record the background image at the same time as the marker and eraser data that is drawn.

[Desktop Drawing Tool: Drawing Data File] group
Sets a default folder other than the folder of the PowerPoint file when processing drawing data files for PowerPoint Slide Show.

3) Click the [OK] button.
Using the Interactive Panaboard Software

### Reference the help

Right-click the icon in the Taskbar and click [Help Topics...] in the pop-up menu.
- The topics on the online help are displayed.

### Display the information about the Interactive Panaboard Software

Right-click the icon in the Taskbar and click [About...] in the pop-up menu.
- The version information of the Interactive Panaboard Software is displayed.

### Exiting the Interactive Panaboard Software

Right-click the icon in the Taskbar and click [Exit] in the pop-up menu.
- The Interactive Panaboard Software ends.
When using a projector to project images, be sure to display the image so that it is centered left-to-right on the electronic print board screen and with at least a 50 mm (2") gap between the top of the image and the screen border. Note that the Electronic Pen does not always operate properly when within 50 mm (2") of the top of the screen, 100 mm (3\(\frac{3}{16}\)"") of the position receiver and 35 mm (1\(\frac{3}{8}\)"") from the both sides of the screen.

Since the Electronic Pen position may shift if the image on the screen is trapezoidal, adjust the projector so that the image on the screen is rectangular.

When projecting an image on the electronic print board using a projector, the image on the screen may become difficult to see depending on the viewing angle and position due to reflected projector light. If this happens, adjust the location of the projector or change your viewing position.

When using a projector to project a PC screen, be sure to use optimum resolution settings for the projector and the PC. The image may be difficult to see if optimum settings are not used. Fine lines in the image on the electronic print board screen may appear broken particularly if the projector resolution is lower than the PC resolution.

When using a projector to project images, the Electronic Pen position may shift if the projection position shifts due to the following causes. If this happens, it becomes necessary to perform calibration to re-position the projected image on the screen. (For details on calibration, please see page 35.)

- When the installed location of the projector is changed.
- When the position of the electronic print board is changed.
- When the projection area and position has changed due to using a projector function such as zoom.
- When the display resolution of the projector or PC has changed.

Note that the position of an electronic print board attached to a stand may shift if it is struck carelessly. Always make sure the stand's casters are locked in place.

Light from the projector may enter the eye when using a projector to project images for the purpose of making presentations and so on. Be very careful as direct projector light may hurt the eyes.
Basic operation flow in Projector mode

This section explains the flow of basic operations when using the Interactive Panaboard Software in the Projector mode. We recommend trying the operations in accordance with the following steps to help you completely understand the operations in the Projector mode.

- For any explanations on the operations of the Projector mode, the Electronic Pen will be referred to as “Mouse” and the projected computer screen on the Interactive Panaboard will be referred to as “Desktop”.

Calibration

Calibration is an operation to calibrate the position of the computer screen projected onto the Interactive Panaboard screen to judge the position by the Interactive Panaboard Software.

1. Start the Interactive Panaboard Software and select the Projector mode. (See page 29.)
   - The calibration screen is displayed.

2. In the sequence of upper left, upper right, lower right and lower left, press for about two seconds for center of each four corner position with the Electronic Pen.
   - When this operation ended correctly, then the next position starts automatically.

3. When the calibration ended correctly, there is a message telling you its finish. From this point onward, the Electronic Pen can be used as the Mouse.

Note

- If you move the projector or Interactive Panaboard, the position of the computer screen projected onto the Interactive Panaboard screen will be changed. This will result in out of position of the Electronic Pen. If this happens, you will need to recalibrate the unit by executing [Calibrate] in the pop-up menu.
- In the Projector mode, use the Electronic Pen with its cap on.
- Do not cover the position receiver with your hand as this may cause interactive function to stop functioning.
- Press down firmly with the point of the Electronic Pen on the screen film until you hear a buzzing sound.
- For precise positioning, keep the Electronic Pen perpendicularly to the Interactive Panaboard screen during use. Inclined pen angle will cause the shift of position.

Remark:

- If recalibration is necessary, click [Calibrate] in the pop-up menu.
Projector Mode

● Use the Electronic Pen as a mouse

After the calibration is completed, the Electronic Pen can be used as a mouse for the projected computer screen on the Interactive Panaboard.

(1) If the Desktop Drawing Tool is not displayed, right-click the icon 🖼 in the Taskbar and click [Tool] · [Draw] to display the Desktop Drawing Tool.

(2) To use the Electronic Pen as a mouse, click 🖼 (Arrow) in the Desktop Drawing Tool. Operations of "click" and "drag" are as follows.

- Single click: Press the projected screen with the tip of the Electronic Pen.
- Double-click: Double-click is executed by performing two quick clicks at the same position with the tip of the Electronic Pen.
- Drag: Press and hold the desire image with the tip of the Electronic Pen while dragging the image to its new position.
- Right-click: Locate light gray button on the Electronic Pen. While pressing the button of the Electronic Pen, press the projected screen with the tip of the Electronic Pen and release. (Do not release the button of the Electronic Pen before all of these operations are finished.)

For more details about the Desktop Drawing Tools, please refer to "About Desktop Drawing Tool" from page 39.

Note

- For precise positioning, keep the Electronic Pen perpendicularly to the Interactive Panaboard screen during use. Inclined pen angle will cause the shift of position.

Remark:

- If double-click does not work properly, confirm that the same position is accurately clicked twice. When the position is different, it is not recognized a double click.
  Or, try different timing of depressing and releasing of the Electronic Pen. This operation is also depending on the setting of the double-click speed in "Mouse" of the Windows "Control Panel".

● Draw and erase handwritten lines on the Desktop

(1) Click either 🖼 (Black, Red, Blue or Green Marker) in the Desktop Drawing Tool to draw handwritten lines.

  - The shape of the mouse cursor changes to 🖼.

(2) Position the mouse pointer where you want to draw a handwritten line on the Desktop and drag the Mouse.

(3) Click 🖼 (Eraser) in the Desktop Drawing Tool to erase the handwritten line.

  - The shape of the mouse cursor changes to 🖼.

(4) Drag the Mouse to the area on the Desktop to be erased.

Remark:

- The width and color of the markers and the size of the eraser can be changed. (See page 41.)
Before you start Using Help Installation Projector Mode

Record image and handwritten lines data on the Desktop

Data of handwritten lines drawn or erased on the Desktop using the Desktop Drawing Tool can be recorded in Interactive Panaboard format files (extension ".ipb", referred to as IPB documents) along with the initial Desktop image. Written or erased handwritten lines are recorded in stroke units and can be displayed, played back and edited later in the View window.

There are two ways to record. For settings of the recording method, refer to "Options" on page 32. This section explains the recording method of [(Method 1) Draw strokes and record after verifying the background image]. For more details on recording methods, refer to "Record Drawing Data in IPB Document" on page 43.

Recording by Using [(Method 1) Draw strokes and record after verifying the background image]

1. Click (REC Start) in the Desktop Drawing Tool.
   - The image of the Desktop is displayed in the dialog box.

2. If it is acceptable to store as a background image, click the [OK] button.
   - If there are drawn lines on the Desktop, a verification dialog box will appear to confirm whether to erase drawings.
     - To erase the drawn lines, click [Yes] button.
     - To leave the drawn lines, click [No] button.

3. Draw lines by using (Black, Red, Blue or Green Marker) or erase drawn line by (Eraser) in the Desktop Drawing Tool.

4. After finishing your drawing and erasing, click (REC Stop) in the Desktop Drawing Tool.
   - The recording image will be displayed in a dialog box.

5. Click the [OK] button to record the recording image.
   - The Save As dialog box will appear.

6. Enter the folder where you want to save the file and the file name.
   - The extension of the file is ".ipb".

7. Click the [Save] button.

Note

- Do not change the Desktop resolution while recording data. If changed, the Desktop image will not be displayed properly when it is displayed in the View window.

Remark:

- More than one page can be recorded. (See page 43.)
Projector Mode

● Playback the recorded data by View window
  Desktop background data and handwritten lines data stored using the Desktop Drawing Tool can be displayed in the View window as well as browsed, played back and edited.
  (1) If the View window is not displayed, right-click the icon in the Taskbar and click [Tool] · [View Window] to display the View window.
  (2) Click [Open...] in the [File] menu.
    ● The Open dialog box will appear.
  (3) Enter the folder to look in and the file name you want to open.
    ● The file has an ".ipb" extension.
  (4) Click the [Open] button.

Remark:
● Many different operations can be executed in the displayed IPB document.
  Save the IPB document in another file format. (See page 59.)
  Switch a page of the IPB document. (See page 62.)
  Edit a page of the IPB document. (See page 63.)
  Playback the IPB document. (See page 66.)
  Recognizing Handwriting in the IPB document. (See page 66.)
  Print the IPB document. (See page 68.)
### About Desktop Drawing Tool

The Desktop Drawing Tool is a tool for drawing, erasing, recording, etc. on the Desktop. In the Projector mode, click [Tool] · [Draw] in the pop-up menu. The Desktop Drawing Tool will be appeared when there is a check mark. While the Desktop Drawing Tool is being displayed, click [Tool] · [Draw] in the pop-up menu. This will delete the check mark and the Desktop Drawing Tool will disappear. The Desktop Drawing Tool is always displayed at the front of the Desktop. From this Desktop Drawing Tool, the tools can be selected for drawing or erasing lines. The data drawn on the Desktop can be stored into the IPB document together with the desktop image. They can be displayed or edited by the View window.

In the Desktop Drawing Tool, following tools can be used.

- **The standard display condition**
  - **Arrow:** Use the electronic pen as the Mouse.
  - **Black Marker:** By dragging the Mouse, black line can be drawn.
  - **Red Marker:** By dragging the Mouse, red line can be drawn.
  - **Blue Marker:** By dragging the Mouse, blue line can be drawn.
  - **Green Marker:** By dragging the Mouse, green line can be drawn.
  - **Eraser:** By dragging the Mouse, lines can be erased.
  - **Undo:** Return the drawing lines line by line.
  - **Redo:** Cancel the undo.
  - **Setting:** The width, color of the markers and size of the eraser can be changed.
  - **All Clear:** Clear all drawn lines.
  - **Capture:** Output the Desktop image as an image file.
  - **Print:** Print out the Desktop image.
  - **On-Screen Keyboard:** Display the On-Screen Keyboard/Handwriting Tablet or clear its display.
  - **PowerPoint slide show:** Plays or quits the PowerPoint Slide Show.
  - **Next:** Performs the same operation as "Next" in a PowerPoint Slide Show.
  - **Previous:** Performs the same operation as "Previous" in a PowerPoint Slide Show.
  - **White Background:** Change the background of the Desktop to the whiteboard. Click once again will release the Whiteboard status.
  - **Refresh:** All of the drawn lines on the Desktop are re-displayed.
  - **REC Start:** In the case of (Method 1), start recording of the data. The capture image of the Desktop is added as an initial data.
  - **REC Start:** In the case of (Method 2), the first page will be recorded.
**Projector Mode**

- **REC Stop:** Stop recording and store the recording data.
- **Page No.:** Display the page number which is being recorded. Before recording, it is (0). When the Recording start button is depressed, it displays as (1), and following pages will be numbered accordingly.
- **New Page:** In the case of (Method 1), saves current page recordings and starts the process to record the next page. Selecting this icon will stop the recording of the current page. The recording process will be paused while the current page is saved and the background for the next page is changed and confirmed. To start the recording process of the next page, select the **REC Start** icon.
- **REC Page:** In the case of (Method 2), the second or subsequent page will be recorded.
- **Shrinking:** Shrinks the Desktop Drawing Tool.
- **Expansion:** Expands the Desktop Drawing Tool.

**Remark:**
- When the Desktop Drawing Tool is closed, the drawings are erased.
- **Next** and **Previous** are only displayed when the PowerPoint Slide Show is running.

### Desktop Drawing Tool operation

- **Draw and erase handwritten lines**

  1. Click either **Black Marker**, **Red Marker**, **Blue Marker** or **Green Marker** in the Desktop Drawing Tool.
     - The shape of the mouse cursor changes to **Pen**.
  2. Position the Mouse where you want to draw a handwritten line on the Desktop and drag the Mouse.
  3. Click **Eraser** in the Desktop Drawing Tool.
     - The shape of the mouse cursor changes to **Eraser**.
  4. Drag the Mouse to the area on the Desktop to be erased.

**Remark:**
- The width and color of the markers and the size of the eraser can be changed. (See page 41.)
- Handwritten lines drawn on the Desktop may be hidden or shifted when an application or a window are operated. If this occurs, click **Refresh** to redisplay the Desktop.
● Change Marker/Eraser settings

Change the width and color of the markers and the size of the eraser used in the Desktop Drawing Tool. The marker width and color can be changed for four marker colors.

1. Click Setting in the Desktop Drawing Tool.
   • The Marker/Eraser Setting dialog box will appear.

2. To change the width of the markers, either enter a width in (Marker Width) at the right side of the marker whose width will be changed or click the arrows at the right and left of the scroll bar or drag the scroll bar to the right or left to set a desired width.

   To change the color of the markers, click (Marker Color) on the right side of the marker whose color will be changed. The Color dialog box will appear. Click the color you want to change from among Basic colors, and click the [OK] button.

   To set a highlight marker, check (turn ON) the [Highlight] check box.

   To change the size of the eraser, either enter a size in (Eraser Radius) or click the arrows at the right and left of the scroll bar or drag the scroll bar to the right or left to set a desired size.

3. Click the [OK] button.

4. A dialog box will appear where you can select whether or not to apply the new settings to handwritten lines drawn up to now.
   • Clicking [Yes] button will redraw the lines drawn up to that point using the new settings.
   • Clicking [No] button will only reflect the new settings for any subsequently drawn lines.

Remark:

• The marker width can be set in a range of 1 - 30 dots.
• When you check (turn ON) the [Same Width] check box, you can set all markers to the same width by only setting the width of the black marker.
• When the marker color is changed, the color will be displayed on the bottom-right of the Desktop Drawing Tool marker button, but the marker tool color will not change.
• When a highlight marker is set, the background under the drawn lines is transparent.
   • In case that the background is dark and the drawn lines are hard to see, please turn the [Highlight] check box OFF. And when the line crosses with one of the different color, the part of that becomes dark.
• The eraser radius can be set in a range of 1 - 60 dots.
• These settings are effective until being changed.

● Erase all handwritten lines on the Desktop

1. Click All Clear in the Desktop Drawing Tool.
   • A verification dialog box will appear.

2. Click the [OK] button to execute all clear.
Save Desktop in image file
Save the background image of the Desktop and handwritten lines that were drawn on the Desktop as an image file.
There are two ways to save files, specifically, saving a file after entering the file name or automatically saving a file with the saving date as its file name. For more details on file saving methods and settings for JPEG file quality levels, refer to "Options" on page 32.

Saving Files by Entering File Names
(1) Click (Capture) in the Desktop Drawing Tool.
   • The Save As dialog box will appear.
(2) Enter the folder where you want to save the file, the file name and the file type.
   The following file formats can be selected for the [File type].
   Bitmap Files (*.bmp), TIFF Files (*.tif) or JPEG Files (*.jpg)
(3) Click the [Save] button.
   • In the Save As dialog box, if an existing TIFF file is selected, another dialog box will be displayed to confirm overwriting it or adding the file to it. Selecting "Yes" will add the image to the end of the existing file as a multi-page TIFF. Selecting "No" will delete the existing image and save as a single-page TIFF file.

Saving Files Automatically, Named with the Date
(1) Click (Capture) in the Desktop Drawing Tool.
   • The save verification dialog box will appear.
(2) Click the [OK] button.
   • Selecting [Do not show this message again] will prevent the save verification dialog box from being shown again. To display it again, set it following the directions in "Options" as shown on page 32.

Print an image of the Desktop
Print the background image of the Desktop and handwritten lines that were drawn on the Desktop.
(1) Click (Print) in the Desktop Drawing Tool.
   • The Print dialog box will appear.
(2) Set the [Printer] and [Number of copies].
(3) Click the [OK] button.
   • The Printing dialog box will appear.
   • To stop the printing, click the [Cancel] button in the Printing dialog box.

Set the background of the Desktop to the Whiteboard
Allow you to make the background of the Desktop totally white.
(1) Click (White Background) in the Desktop Drawing Tool.
   • In addition, click (White Background) again to return the background of the Desktop to its original state.

Redisplay handwritten lines drawn on the Desktop
Handwritten lines drawn on the Desktop may be hidden or shifted when an application or a window are operated. If this occurs, redisplay the Desktop.
(1) Click (Refresh) in the Desktop Drawing Tool.
Record drawing data in IPB document

Create an IPB document to record work performed on the Interactive Panaboard.
There are two ways to record. For information on system settings, refer to "Options" on page 32.

Recording by Using [(Method 1) Draw strokes and record after verifying the background image]

Clicking (REC Start) in the Desktop Drawing Tool will record the Desktop image at that moment as a background and any handwritten lines drawn or erased on the Desktop on a page in stroke units.
A page is a unit of recorded work performed on the Desktop. If (New Page) is used to add a page when switching screens on the Desktop, the contents of the Desktop and the page can be synchronized.
The recording operation will stop when (REC Stop) is clicked and the data saved as an IPB document.

1. Click (REC Start) in the Desktop Drawing Tool.
   ● The image of the Desktop will be displayed in a dialog box.

2. Click the [OK] button to store the data as the background image of the 1st page.
   ● If there are drawn lines on the desktop, a verification dialog box will appear to confirm whether to erase drawings.
     To erase the drawn lines, click [Yes] button.
     To leave the drawn lines, click [No] button.

3. Use the (Black Marker, Red Marker, Blue Marker or Green Marker) in the Desktop Drawing Tool to draw handwritten lines.
   In addition, use the (Eraser) to erase unwanted handwritten lines.

4. Click (New Page) to add a page.
   If no pages will be added, advance to step 11.
   ● The recording image will be displayed in a dialog box.

5. Click the [OK] button to record the recording image.
   ● A verification dialog box will appear to confirm whether to erase the drawings.

6. Click the [Yes] button to erase the drawings.
   Or, click the [No] button to leave the drawings.
   ● The recording process is paused. The Electronic Pen cursor will automatically change to the mouse arrow cursor, allowing the background image to be changed.
     While the recording process is paused, all of the Desktop Drawing Tool icons are inactive except the (REC Start) and (White Background) icons.

7. Switch the Desktop to the desired background.

8. Click (REC Start) to restart the recording of a new page.
   ● The image of the Desktop will be displayed in a dialog box.

9. Click the [OK] button to store the data as the background image of a new page.
   ● All of the Desktop Drawing Tool icons will become active.

10. To add multiple pages, repeat steps 3 to 9.

11. Click (REC Stop) in the Desktop Drawing Tool.
    ● The recording image will be displayed in a dialog box.

12. Click the [OK] button to record the recording image.
    ● The Save As dialog box will appear.
Projector Mode

(13) Enter the folder where you want to save the file and the file name.
   ● The extension of the file is ".ipb".

(14) Click the [Save] button.

Recording by Using [(Method 2) Record strokes and background image together]

Clicking \(\text{(REC Start)}\) in the Desktop Drawing Tool will record the Desktop image at that moment without handwritten lines as a background and record any handwritten lines previously drawn or erased on the Desktop on a page in stroke units. For the second or subsequent page, clicking \(\text{(REC Page)}\) in the Desktop Drawing Tool will record the Desktop image and handwritten lines as well. The recording operation will stop when \(\text{(REC Stop)}\) is clicked and the data will be saved as an IPB document.

(1) Switch the Desktop to the desired background. Use \(\text{(Black Marker, Red Marker, Blue Marker or Green Marker)}\) in the Desktop Drawing Tool to draw handwritten lines. In addition, use the \(\text{(Eraser)}\) to erase unwanted handwritten lines.

(2) Click \(\text{(REC Start)}\) in the Desktop Drawing Tool.
   ● The image to be recorded for the current page will be displayed in a dialog box.
   ● For the second or subsequent page, click \(\text{(REC Page)}\) in the Desktop Drawing Tool instead of \(\text{(REC Start)}\).

(3) To record, click button [Record] or [Record & Erase drawings].
   ● Clicking the [Record] button will preserve the drawing after recording.
   ● Clicking the [Record & Erase drawings] button will erase the drawing after recording.
   ● Clicking the [Cancel] button will cancel recording.

(4) To add multiple pages, repeat steps 1 to 3.

(5) Click \(\text{(REC Stop)}\) in the Desktop Drawing Tool.
   ● The Save As dialog box will appear.

(6) Enter the folder where you want to save the file and the file name.
   ● The extension of the file is ".ipb".

(7) Click the [Save] button.

Note

● Do not change the Desktop resolution while recording data using method 1 or method 2. If changed, the Desktop image will not be displayed properly in the View window.

Remark:

● While using method 1 to record data, page numbers can be verified by \(\text{(PageNo)}\) in the Desktop Drawing Tool. Before starting to record data, the data value is "0" and it will change to "1" when \(\text{(REC Start)}\) is clicked. The value will then count up for each page break. When switching the computer screen being projected onto the screen of the Interactive Panaboard during a meeting, begin drawing after adding \(\text{(New Page)}\) and recording the background image of the new page.

● While using method 2 to record data, the number of pages can be verified by \(\text{(PageCount)}\) in the Desktop Drawing Tool. Before starting to record data, the data value is "0" and it will change to "1" when \(\text{(REC Start)}\) is clicked. The value will then count up each time the record button is pressed.

● A maximum of 50 pages can be stored.
● Controlling a PowerPoint Slide Show

A PowerPoint Slide Show can be run using the Desktop Drawing Tool. In addition, because the functions Next and Previous can also be performed, there is no need to momentarily change to the pointer to switch slides when selecting the Marker or Eraser. Drawing data is recorded for each slide, so the drawing data will always be displayed for the corresponding slide. Drawing data can be saved in a file, which enables reuse the next time the presentation is run.

To use the PowerPoint Slide Show features, PowerPoint® 97 or later must be installed on the computer.

The drawing data for slides is used by the Desktop Drawing Tool. It is not PowerPoint data.

Running a Slide Show

1. Click (PowerPoint Slide Show) in the Desktop Drawing Tool.
   • The Open dialog box will appear.
2. Enter the file path and file name of the PowerPoint file that runs the Slide Show.
   • The file name extension is ".ppt".
3. Click the [Open] button.
   • PowerPoint will be launched and the Slide Show will automatically run.

Remark:

• Clicking (PowerPoint Slide Show) when the PowerPoint file is open will automatically run the Slide Show of the open file without displaying the Open dialog box. This will be the Slide Show controlled.
• To control a Slide Show that PowerPoint is running, click (PowerPoint Slide Show).

Switching Slides in the Slide Show

The Desktop Drawing Tool displays (Next) and (Previous) buttons when a Slide Show is running.

1. Click (Next) or (Previous) in the Desktop Drawing Tool.
   • These perform the same operation as "Next" and "Previous" in a PowerPoint Slide Show.

Remark:

• The drawing data will not be displayed when switching slides without using the Desktop Drawing Tool. In this case, clicking (Refresh) button will display the drawing data.

Quitting the Slide Show

1. Click (PowerPoint Slide Show) in the Desktop Drawing Tool when the Slide Show is running.
   • The PowerPoint Slide Show will be stopped.

Remark:

• If the end of the Slide Show is reached through (Next) or other operations without clicking (PowerPoint Slide Show), the Desktop Drawing Tool will automatically sense the end of the Slide Show and stop.
Saving the Drawing Data for Slides
After the Desktop Drawing Tool has stopped, a dialog box will be displayed to confirm whether to save as a file the handwritten data that was drawn on slides with markers or erased from slides with erasers. If the handwritten data is saved through this dialog box, it will be named with the same name as the PowerPoint file (with the file extension ".ips"). By default, it will be saved to the same folder as the PowerPoint file. If the file cannot be saved to this folder, it will be saved to the folder set in "Options" as explained on page 32.

Remark:
- The drawing data is saved in a proprietary format as a drawing data file with the file extension ".ips".

Using the Saved Drawings with Slides
When [PowerPoint Slide Show] is clicked, if there is a drawing data file in the same folder as the PowerPoint file or in the folder set in "Options" (page 32) with the same name as the PowerPoint file, a dialog box will be displayed to confirm whether to use the file. If the file is chosen for use, the data will be loaded and displayed with the slides.

Remark:
- If a drawing data file that was saved is no longer needed, delete it using Windows Explorer or a similar means.

Switching the Desktop Drawing Tool Display
The Desktop Drawing Tool can be displayed in three sizes.
[Standard Display]
Shows all buttons.
[Marker Display]
Shows only the buttons used for drawing and erasing handwritten lines. Does not show the buttons for saving image files or recording IPB documents.
[Compact Display]
Use the Compact Display when the Desktop Drawing Tool covers up too much of the image behind it. It keeps the part that is hidden to a minimum.

Switching among the [Standard Display], [Marker Display] and [Compact Display] views can be done by clicking the [Shrinking] or [Expansion] buttons.

Remark:
- Tools cannot be modified in the [Compact Display] view.
- During PowerPoint Slide Show, the [Standard Display] and [Marker Display] views show [Next] and [Previous] buttons.
About On-Screen Keyboard

On-Screen Keyboard is a tool which the user can use to input data: it displays a virtual keyboard on the computer screen which has been projected onto the Interactive Panaboard screen, and the user can then proceed to click the keys on this keyboard. It can also be used with the handwriting tablet to recognize handwriting to be input as data.

In the projector mode, it is displayed by clicking [Tool] · [On-Screen Keyboard] in the pop-up menu and placing a check mark in the check box. If [Tool] · [On-Screen Keyboard] in the pop-up menu is clicked while the keyboard is displayed and the check mark is removed, the On-Screen Keyboard is cleared from the display. The On-Screen Keyboard can also be displayed and its display cleared on the Desktop Drawing Tool. (See page 39.)

The On-Screen Keyboard provided with Windows can also be used instead of the original keyboard. (See page 32.)

On-Screen Keyboard operation

Using the On-Screen Keyboard to input data

1. Click [ ] (On-Screen Keyboard (Handwriting Tablet)) in the Desktop Drawing Tool.

   If the Handwriting Tablet appears, click [ ] button on the Handwriting Tablet to change to the On-Screen Keyboard. Selecting [Standard Keyboard] or [Enhanced Keyboard] from the [Keyboard] menu of the Handwriting Tablet is also available to change to the On-Screen Keyboard.

2. Activate the target application window for input. Align the text cursor with the input field.

3. Click the characters on the On-Screen Keyboard.

Remark:

The title of the target application for input currently is displayed as the On-Screen Keyboard title.
Projector Mode

● Entering Data with the Handwriting Tablet

(1) Click (On-Screen Keyboard (Handwriting Tablet)) in the Desktop Drawing Tool.
   ● If the On-Screen Keyboard appears, click button on the On-Screen Keyboard to change to the
     Handwriting Tablet. Selecting [Handwriting Tablet] from the [Keyboard] menu of the On-Screen
     Keyboard is also available to change to the Handwriting Tablet.

(2) Activate the target application window for input. Align the text cursor with the input field.

(3) Use the Electronic Pen to write text in the Handwriting Tablet.
   ● The handwriting will be recognized and displayed on the upper-left of the Handwriting Tablet.

(4) Click the [send] button of the Handwriting Tablet.

Remark:

● English or German handwriting is the only language that can be recognized.
  Handwriting recognition for German will be available only when German is selected in "Regional Setting" of
  the Windows "Control Panel".
● The recognized text can be cleared by clicking [clear] without clicking [send].
● Words that are possibly misspelled will be displayed with wavy underlining.
  To correct words that might be misspelled, right-click on the word and select from the list of alternatives.
  However, in some cases, no alternatives will be displayed.
● It is possible to enter the text directly into the target application without clicking the [send] button. This setting
  can be performed by selecting [Handwriting Tablet] from the [Settings] menu. (See page 49.) However, no
  spell check will be performed in this case.

● Selecting the On-Screen Keyboard display method

(1) On the [Keyboard] menu, select one of the following.

   Enhanced Keyboard : A keyboard with a numeric keypad appears.
   Standard Keyboard : A keyboard without a numeric keypad appears.
   Handwriting Tablet : Displays the entry tablet for handwriting recognition.
● Selecting the On-Screen Keyboard layout
(1) On the [Keyboard] menu, select one of the following.
101 keyboard: The U.S. standard keyboard appears.
102 keyboard: The general-purpose keyboard appears.

Remark:
● If the data which has actually been input does not match the characters displayed on the On-Screen Keyboard, ensure that the input locale settings match. The input locale can be set using [Input locale] in "Keyboard" of the Windows "Control Panel".

● Continuously displaying the On-Screen Keyboard at the top of the screen
(1) Click [Always On Top] on the [Settings] menu, and place a check mark in the box.

Remark:
● If the On-Screen Keyboard is not to be displayed continuously kept at the top of the screen, click [Always On Top] on the [Settings] menu to remove the check mark from the box.

● Changing the size of the On-Screen Keyboard
(1) Using [Resize] on the [Settings] menu, click the desired On-Screen Keyboard size.

Remark:
● Alternatively, the size of the On-Screen Keyboard can be changed by dragging one of the edges of the On-Screen Keyboard window.
● The aspect ratio of the On-Screen Keyboard is fixed.
● The width of the window size ranges from one-half to double the [Middle] size.
● The keyboard size in [Standard Keyboard] mode or [Enhanced Keyboard] mode cannot be changed by dragging the upper or lower borders.
● The tablet size in [Handwriting Tablet] mode cannot be changed by dragging the upper border.

● Modifying the Handwriting Tablet Settings
(1) Click [Handwriting Tablet...] in the [Settings] menu.
● The Handwriting Tablet Settings dialog box will appear.

(2) The following items can be set.
Waiting Time to Recognition: Sets the standby time after handwritten input until recognition is started.
Add Space: Specifies whether or not to add a space after the recognized text.
Send Recognition Directly: Specifies whether or not to send recognized text directly to the target application immediately after recognition.

(3) Click the [OK] button.
Projector Mode

About View window

Desktop background data and data of handwritten lines recorded using the Desktop Drawing Tool can be displayed in the View window as well as browsed, reproduced and edited. In the View window, display and edit of the IPB documents which is recorded by the Desktop Drawing Tool are possible. It can also be used for handwriting recognition for output as text.

In the Projector mode, click [Tool] · [View Window] in the pop-up menu to get the check mark, then the View window will appear. While displaying the View window, click [Tool] · [View Window] in the pop-up menu to delete the check mark, then the View window will disappear.

1. Title bar: Indicate the currently opened file name of the IPB document.
2. Main view: In the main view, the page to be edited is displayed. When (Arrow) is selected in the [Markers/Eraser] Toolbar, a part of page can be copied into the Clipboard by dragging the mouse. It can be copied to other application software by drag and drop. When marker is selected in the [Markers/Eraser] Toolbar, you can draw lines on the page. If the eraser is selected, you can erase the lines.
3. Thumbnail view: The thumbnail image of the all pages of the IPB document can be displayed. At the bottom of each page, the last modified date is displayed. The image in the main view area is indicated as framing in the thumbnail area. To change the editing page, click another page.
4. Toolbar: Toolbar has buttons which most frequently used functions are formed as icon. It can be moved in the display area by dragging.
5. Status bar: Indicate the information of the IPB document.
6. Replay mode: Indicate if it is in the replaying or not.
7. Image size: Indicate the page size when it is 100% display ratio.
8. Page number: Indicate the total number of pages and the page being displayed.
9. Text Editor: Receives the data handwriting that has been recognized. Enables editing of the text.

For more details about the View window, refer to “View Window or Whiteboard Window Operation” from page 54.
Whiteboard Mode

Basic operation flow in Whiteboard mode

This section explains the flow of basic operations when using the Interactive Panaboard Software in the Whiteboard mode. We recommend trying the operations in accordance with the following steps to help you completely understand the operations in the Whiteboard mode.

Drawing and erasing handwritten lines on the Interactive Panaboard screen

When the Whiteboard window is displayed, set one of the four different types of the markers for interactive (Small) used for the Electronic Pen, remove the cap and draw on the Interactive Panaboard. The content of the drawing will be displayed on a page in the Whiteboard window in real-time. Further, if you use the Electronic Eraser to erase the contents drawn on the screen, the handwritten lines displayed on the page in the Whiteboard window will be erased as well.

These drawing and erasing operations are recorded automatically.

1. Start the Interactive Panaboard Software and select the Whiteboard mode. (See page 29.)
   - The Whiteboard window is displayed.

2. Remove the cap of the Electronic Pen and draw on the Interactive Panaboard screen using the Electronic Pen.
   - The position on the screen where you are drawing will be reproduced on the page in the Whiteboard window in real-time.

   - Portions erased on the screen will also be erased on the page in the Whiteboard window.

Note

- The right figure shows the writing area in the Whiteboard mode.
  Do not write the shaded area on the right figure.
- Do not cover the position receiver with your hand as this may cause interactive function to stop functioning.
- Press down firmly with the point of the Electronic Pen or the eraser on the screen film until you hear a buzzing sound.
- Do not do the followings near (less than 1 m (3.3')) the Interactive Panaboard while using the Whiteboard mode as this may display unnecessary streaks not written in the Whiteboard window.
  - Exchanging markers for interactive (Small) of the Electronic Pen
  - Setting or removing a marker cap of the Electronic Pen
  - Pushing the point of the Electronic Pen
- When exchanging markers for interactive (Small) of the Electronic Pen, lock the pen holder lever while inserting the marker all the way into the pen holder until you hear a buzzing sound.

Detection of the marker color may not work well unless the marker is inserted fully into the pen holder.

Remark:

Whiteboard Mode

Save drawing data in a file
All drawing and erasing operations of the Interactive Panaboard which are reproduced on a page in the Whiteboard window are automatically recorded. And if the data is saved in the Interactive Panaboard format file (extension ".ipb", referred to as IPB documents), the details of meetings and discussions written in the Panaboard can be played back and edited later.

(1) Click [Save As...] in the [File] menu.
   - The Save As dialog box will appear.

(2) Enter the folder where you want to save the file and the file name.
   - The extension of the file is ".ipb".

(3) Click the [Save] button.

Open the saved data
The saved data can be displayed in the Whiteboard window as well as browsed, played back and edited.

(1) Click [Open...] in the [File] menu.
   - The Open dialog box will appear.

(2) Enter the folder to look in and the file name you want to open.
   - The file has an ".ipb" extension.

(3) Click the [Open] button.

Remark:
Many different operations can be executed in the displayed IPB document.
- Save the IPB document in another file format. (See page 59.)
- Switch a page of the IPB document. (See page 62.)
- Edit a page of the IPB document. (See page 63.)
- Playback the IPB document. (See page 66.)
- Recognizing Handwriting in the IPB document. (See page 66.)
- Print the IPB document. (See page 68.)
About Whiteboard window

Whiteboard window is a function to reproduce the drawn lines by using the Electronic Pen and the Electronic Eraser onto the Interactive Panaboard to the computer screen. Recorded image data can be saved as IPB document. So that you can see the file later. The following functions are available; Add lines with marker. Erase unnecessary lines with eraser. Copy entire page or partial image to other general image formats such as Bitmap, JPEG, TIFF and these images can be transferred to other application software. It can also be used for handwriting recognition for output as text.

Either start with the Whiteboard mode or click [Open Whiteboard Window] in the pop-up menu to get the check mark in the Whiteboard mode, then the Whiteboard window will appear. While displaying the Whiteboard window, click [Close Whiteboard Window] in the pop-up menu to delete the check mark, then the Whiteboard window will disappear.

Title bar: Indicate the currently opened file name of the IPB document.

Main view: In the main view, the page to be edited is displayed. When (Arrow) is selected in the [Markers/Eraser] Toolbar, a part of page can be copied into the Clipboard by dragging the mouse. It can be copied to other application software by drag and drop.

When marker is selected in the [Markers/Eraser] Toolbar, you can draw lines on the page. If the eraser is selected, you can erase the lines.

Thumbnail view: The thumbnail image of all the pages of the IPB document can be displayed. At the bottom of each page, the last modified date is displayed. The image in the main view area is indicated as framing in the thumbnail area. To change the editing page, click another page.

Toolbar: Toolbar has buttons which most frequently used functions are formed as icon. It can be moved in the display area by dragging.

Status bar: Indicate the information of the IPB document.

Replay mode: Indicate if it is in the replaying or not.

Image size: Indicate the page size when it is 100% display ratio.

Page number: Indicate the total number of pages and the page being displayed.

Text Editor: Receives the data handwriting that has been recognized. Enables editing of the text.

For more details about the Whiteboard window, refer to "View Window or Whiteboard Window Operation" from page 54.
View Window or Whiteboard Window Operation

Differences between the View window and the Whiteboard window

The View window of the Projector mode and the Whiteboard window of the Whiteboard mode are windows which function to display and edit IPB documents in which the contents of work performed on the Interactive Panaboard are recorded. Basically, they both have identical functions. However, the Whiteboard window has some functions the View window does not have. If you understand the differences between the two windows as follows, you will be able to quickly use both windows just by learning the operations of one window.

<table>
<thead>
<tr>
<th>Difference</th>
<th>Details</th>
</tr>
</thead>
</table>
| System of units    | ● The View window displays IPB documents which record work done in the computer screen that is projected onto the Interactive Panaboard screen by the projector. Consequently, the size is represented by dots.  
● In the Whiteboard window the state of the Interactive Panaboard screen where the marker was used to draw is virtually displayed in a computer window. Consequently, units of length are standard. You can choose between units in millimeters or inches. |
| [File] menu [New]: | ● The View window function displays and edits IPB documents created by the Desktop Drawing Tool. Consequently, the [New] menu does not exist.  
● Close the IPB document currently displayed in the Whiteboard window and displays a new IPB document. |
| [Edit] menu [Add New Page]: | ● The View window function displays and edits IPB documents created by the Desktop Drawing Tool. Consequently, the [Add New Page] menu does not exist.  
● Add a new page that has no drawing data next to the last page of the IPB document in the Whiteboard window. |
| [Edit] menu [Add Copy Page]: | ● The View window function displays and edits IPB documents created by the Desktop Drawing Tool. Consequently, the [Add Copy Page] menu does not exist.  
● Add a copy of the page displayed next to the last page of the IPB document in the Whiteboard window. |

Menu configuration

Following menus can be used in the View window or the Whiteboard window.

[File] menu

- **New:** Close the displayed IPB document, create a new IPB document.  
  (Whiteboard window only) → Page 58
- **Open:** Open an IPB document. → Page 58
- **Save:** Save the displayed IPB document. → Page 59
- **Save As:** Save the displayed IPB document with new file name. → Page 59
- **Print Preview:** Before printing, check printing layout the displayed IPB document. → Page 68
- **Print:** Print the displayed IPB document. → Page 68
View Window or Whiteboard Window Operation

Export
- Image: Output the page to the image file (Bitmap, JPEG, TIFF). ⇒ Page 59
- HTML: Output the page to the HTML file. ⇒ Page 59

Close View window: Close the View window. (View window only)
Close Whiteboard window: Close the display of the Whiteboard window. (Whiteboard window only)

[Edit] menu
- Undo: Return the drawing lines line by line. ⇒ Page 63
- Redo: Cancel the undo. ⇒ Page 63
- Copy: Copy the selected area in the page to the clipboard. The page size to be copied is 100% zoom condition. ⇒ Page 65
- Select All: Select entire page. ⇒ Page 65
- Add New Page: Add a new page next to the last page. (Whiteboard window only) ⇒ Page 64
- Add Copy Page: Add copied page next to the last page. (Whiteboard window only) ⇒ Page 64
- Delete Current Page: Delete the displayed page. ⇒ Page 64
- Handwriting Recognition: Used for recognition of handwriting for output as text. ⇒ Page 66

[Edit] Menu (When editing using the Text Editor)
- Undo: Restores the state before the last text action. ⇒ Page 67
- Redo: Cancel the undo. ⇒ Page 67
- Cut: Removes the selected text and copies it to the clipboard. ⇒ Page 67
- Copy: Copies the selected text to the clipboard. ⇒ Page 67
- Copy All Pages: Copies the text of all pages to the clipboard. ⇒ Page 67
- Paste: Applies the text in the clipboard. ⇒ Page 67
- Delete: Removes the selected text. ⇒ Page 68
- Select All: Selects all the text of a page. ⇒ Page 68

[Page/Play] menu
- Start: Start the replay. ⇒ Page 66
- Pause: Pause the replay. ⇒ Page 66
- Stop: Stop the replay. ⇒ Page 66
- Playback Option
  - All Pages: Set Playback Option as All Pages. ⇒ Page 69
  - Selected Page: Set Playback Option as Selected Page. ⇒ Page 69
  - Loop Playback: Set Playback Option as Loop Playback. ⇒ Page 69
View Window or Whiteboard Window Operation

- **Go to First Page:** Display the first page. ➔ Page 62
- **Go to Previous Page:** Display the previous page. ➔ Page 62
- **Go to Next Page:** Display the next page. ➔ Page 62
- **Go to Last Page:** Display the last page. ➔ Page 62
- **Go to Page:** Display the specified page. ➔ Page 63

[View] menu

- **Fit Window:** Display the current page to fit window. ➔ Page 62
- 200%: Display the current page by 200% of its original size. ➔ Page 62
- 150%: Display the current page by 150% of its original size. ➔ Page 62
- 100%: Display the current page by 100% of its original size. ➔ Page 62
- 75%: Display the current page by 75% of its original size. ➔ Page 62
- 50%: Display the current page by 50% of its original size. ➔ Page 62
- 25%: Display the current page by 25% of its original size. ➔ Page 62
- 10%: Display the current page by 10% of its original size. ➔ Page 62

- **Full Screen:** Use the entire display area of your monitor to display the current page. ➔ Page 62

- **Main Toolbar:** Switch the Main Toolbar display ON/OFF. ➔ Page 57
- **Page/Play:** Switch the Page/Play Toolbar display ON/OFF. ➔ Page 57
- **Markers/Eraser:** Switch the Markers/Eraser Toolbar display ON/OFF. ➔ Page 57
- **Status Bar:** Switch the Status bar display ON/OFF.
- **Text Editor:** Switch the Text Editor display ON/OFF.

[Settings] menu

- **Information:** Store the information of the meeting. ➔ Page 69
- **Play:** Change the conditions when replaying the drawing data. ➔ Page 69
- **Markers and Eraser:** Change the color and size of the marker and size of the eraser. ➔ Page 70
- **Export Image:** Set the quality of JPEG or compression of TIFF etc. ➔ Page 71
- **File:** Change the folder of IPB document management default or automatic back up interval timing. ➔ Page 71
- **Spell Check:** Settings for checking spelling of handwriting that has been recognized. ➔ Page 72
- **Options:** Set the measurement unit such as mm or inch and the File path display method to the title bar. ➔ Page 72

[Help] menu

- **Help Topics:** To display help information.
- **About:** To display information about the Interactive Panaboard Software.
View Window or Whiteboard Window Operation

Tool bars

Following menus can be used in the View window or Whiteboard window.

- **Main Toolbar**
  
  ![Main Toolbar](image)

  *The [New] button is only for the Whiteboard window.*

- **Page/Play Toolbar**
  
  ![Page/Play Toolbar](image)

- **Markers/Eraser Toolbar**
  
  ![Markers/Eraser Toolbar](image)

To display a Toolbar, click the [View] menu and then click the Toolbar you want to display (any one of [Main], [Page/Play], [Markers/Eraser]) and add a check mark.

If the Toolbar is already displayed, add a check mark next to that Toolbar.

To turn off the Toolbar, click [View] menu and remove the check mark from the Toolbar you want to hide.

If the Toolbar is not displayed, a check mark will not be added next to that Toolbar.

**Remark:**

- The Toolbars can be dragged and moved to any location on the screen.
View Window or Whiteboard Window Operation

Create an IPB document (Whiteboard window only)

In the Whiteboard mode, create new IPB document to record work performed on the Interactive Panaboard.

1  Click [New...] in the [File] menu.
   ○ When the IPB document currently being edited is changed, a dialog box will display asking you to confirm the save.

Remark:

○ When the Whiteboard window is displayed, an IPB document is automatically created and a new page is displayed in the main view.
○ When advancing the screen of the Interactive Panaboard during a meeting, add a new page by [Add New Page] in the [Edit] menu.

Open an IPB document

1  Click [Open...] in the [File] menu.
   ○ The Open dialog box will appear.

2  Enter the folder to look in and the file name you want to open.
   ○ The file has an "ipb" extension.

3  Click the [Open] button.

Remark:

○ To open a recently opened file, click the file name you want to open in the [File] menu. Eight recently opened IPB documents will be displayed in the [File] menu.
○ The IPB documents can also be opened by double-clicking the file icon in the file system.
   Whether an IPB document is created in Projector mode or Whiteboard mode, the contents are managed internally and when opened, the mode they were created in will be switched to automatically.
○ To allow a previously saved IPB document to be recovered if a power failure or other incident occurs, add a check mark to the [Create Recovery File] check box in the [File Settings] dialog box ([Settings] · [File...]) in advance.
   Open the recovery file setting [All Files] in the [Files of type] box as the recovery file have an "ip~" extension.

Save the IPB document

Click [Save] in the [File] menu.

Remark:

○ To save a currently open IPB document with a different name, click [Save As...] in the [File] menu.
Save the IPB document in another file format

Exporting images allows you to save files in another file format to allow the IPB documents to be used in other applications. This makes it possible to easily distribute the contents of meetings stored in the IPB document to users whose computers do not have the Interactive Panaboard Software installed.

Save the IPB document as an image file

(1) Click [Export] · [Image...] in the [File] menu.
   - The Export Image dialog box will appear.

(2) To save all the pages, click [All pages].
   - In addition, to specify certain pages to be saved, click [Page from] and then enter the page range.
   - Clicking the [Setup] button will allow you to set image size, JPEG file quality and TIFF file compression.

(3) Click the [OK] button.
   - The Save As dialog box will appear.

(4) Enter the folder where you want to save the file, the file name and the file type.
   - The following file formats can be selected for the [Save as type].
     - Bitmap Files (*.bmp), TIFF Files (*.tif) or JPEG Files (*.jpg)
     - When specifying TIFF to save multiple pages, multiple-page or single-page files can be selected.

(5) Click the [Save] button.

Remark:

- If multi-page format is not chosen when saving multiple pages as TIFF files, the number of files (ex. "n") created will correspond to the number of pages. A two-digit extension will be added after the file name (such as "01", "02", "03", etc.) to match the page number.
- When saving as a multi-page TIFF file, if an existing TIFF file is selected, another dialog box will be displayed to confirm overwriting it or adding the file to it. Selecting "Yes" will add the image to the end of the existing file as a multi-page TIFF. Selecting "No" will delete the existing image and save as a single-page TIFF file.
- When saving a single page with an existing TIFF file name, another dialog box will be displayed to confirm overwriting it or adding the file to it. Selecting "Yes" will add the image to the end of the existing file as a multi-page TIFF. Selecting "No" will delete the existing image and save as a single-page TIFF file.
- Settings such as size and compression when saving the IPB document as an image file are managed in [Export Image...] in the [Settings] menu.
Save the IPB document as a HTML file

You can save the IPB document as a HTML file in page units. In addition, meeting information can also be output at the same time to that index page. Setting multiple pages and saving the IPB document as a HTML file will create an index file, linked HTML pages and images. Using this method will allow the contents of meetings recorded in the IPB documents to be easily provided to people using computers with Web browsers installed.

2. Specify the folder where the IPB document will be saved as a HTML file in the [index file].
   - Selecting [All Pages] will output all the pages of the displayed IPB document to the HTML files.
   - Selecting [Current Page] will output only the page displayed in the main view to the HTML file.
   - Selecting [Pages] will output the specified page or the specified page range to the HTML file. Enter a comma to separate the page numbers to output the specified pages. In addition, when specifying a page range, use a hyphen to connect the first page number and the last page number.
3. If necessary, change the other export settings shown below and click the [OK] button.

   [File] group
   
   Page Image: Enter the width and height of the image of the exported page in pixel units. Checking (turning ON) the [Constrain Proportions] check box on the right side will preserve the ratio of the length and height of the page even if the dimensions of the exported page are changed.

   Thumbnail Image: Enter the width and height of the thumbnail image of the exported page in pixel units. Checking (turning ON) the [Constrain Proportions] check box on the right side will preserve the ratio of the length and height of the page even if the dimensions of the exported page are changed.

   [Colors] group
   
   Background: Select the color of the background of the HTML file.
   
   Text: Select the color of the text used in the HTML file.
   
   Table Labels: Select the background color of the labels of the tables in the HTML file.
   
   Table Items: Select the background color of the items of the tables in the HTML file. Clicking the rectangular colored portion will display the Color dialog box. Click the color from the Basic colors.
View Window or Whiteboard Window Operation

[Export Contents] group

**Thumbnail Image:** Turn this check box ON to add a thumbnail image of the page to the index page of the exported HTML file.

**Page Date:** Turn this check box ON to display the date and time the page was created on the index page of the exported HTML file.

**Created Date:** Turn this check box ON to display the date and time the IPB document was created on the index page of the exported HTML file.

**Modified Date:** Turn this check box ON to display the date and time of the last update done to the IPB document on the index page of the exported HTML file.

**Participants:** Turn this check box ON to display the participants of the meeting information set in [Information...] in the [Settings] menu on the index page of the exported HTML file.

**Manager:** Turn this check box ON to display the manager of the meeting information set in [Information...] in the [Settings] menu on the index page of the exported HTML file.

**Subject:** Turn this check box ON to display the subject of the meeting information set in [Information...] in the [Settings] menu on the index page of the exported HTML file.

**Description:** Turn this check box ON to display the description of the meeting information set in [Information...] in the [Settings] menu on the index page of the exported HTML file.

**Contacts:** Turn this check box ON to display the contacts of the meeting information set in [Information...] in the [Settings] menu on the index page of the exported HTML file.

**Company:** Turn this check box ON to display the company name of the meeting information set in [Information...] in the [Settings] menu on the index page of the exported HTML file.

**Note**
- We recommend saving HTML files in folders where HTML files exported from other IPB documents are not stored. If you attempt to save a file in an already existing folder, a message will be displayed asking you to confirm whether or not to overwrite the already existing HTML file.

**Remark:**
- When exporting multiple pages to HTML files, an index file “index.html” and HTML files named after the page numbers (for example, n pages) “page_01.html, page_02.html, page_03.html, --- page_0n.html” are created. Images displayed in the HTML files named after the page numbers “page_01.jpg, page_02.jpg, page_03.jpg, --- page_0n.jpg” are also created.
- If the Thumbnail Image check box is turned ON, thumbnail images displayed in the HTML files named after the page numbers “small_01.jpg, small_02.jpg, small_03.jpg, --- small_0n.jpg” are also created.
**View Window or Whiteboard Window Operation**

### Change display method

- **Display expanded/reduced page**
  You can expand the page and display a portion of the page larger or reduce the page and display the entire page.

  (1) Position the cursor over [Zoom] in the [View] menu and click the percentage (%) you want to display.

**Remark:**

- You can also enter a numeric value into (Zoom) to change the display percentage. The percentage can be set in units of 1%.

- **Display page at the same size of the main view**
  
  (1) Click [Fit Window] in the [View] menu.

- **Display page as large as possible**
  
  To display the page on the screen as large as possible, switch to full screen display mode. In this mode the toolbar is displayed as a free toolbar.

  (1) Click [Full Screen] in the [View] menu.

  - To exit full screen display mode and return to the original display mode, right-click the mouse and click [Full Screen] in the pop-up menu.

**Remark:**

- To turn OFF the Toolbar in full screen display, right-click the mouse and click the Toolbar you want to turn OFF in the pop-up menu and remove the check mark.
- In addition, to display the Toolbar, click the Toolbar you want to display in the pop-up menu and add the check mark.

### Switch a page of the IPB document

- **Display first page**
  
  (1) Click [Go to First Page] in the [Page/Play] menu.

- **Display previous page**
  
  (1) Click [Go to Previous Page] in the [Page/Play] menu.

- **Display next page**
  
  (1) Click [Go to Next Page] in the [Page/Play] menu.

- **Display last page**
  
  (1) Click [Go to Last Page] in the [Page/Play] menu.
View Window or Whiteboard Window Operation

● Specify a page number to display
  (1) Click [Go to Page...] in the [Page/Play] menu.
  ● The Go to Page dialog box will appear.

  (2) Enter the page number you want to display in [Go to Page:].

  (3) Click the [OK] button.

  Remark:
  ● To quickly display a page, click the thumbnail display of the page you want to display in thumbnail view.

■ Edit a page of the IPB document

You can edit pages displayed in the main view in the View window or Whiteboard windows as follows.
  ● You can use the marker or eraser for additions and modifications.
  ● You can add a page. (Whiteboard window only)
  ● You can delete a page.
  ● You can select portions or entire page and save the contents in the clipboard or copy to other applications.

● Draw and erase handwritten lines on a page

(1) Display the page where you want to draw or erase handwritten lines in main view.

(2) To draw handwritten lines, click either [Marker] (Black Marker, Red Marker, Blue Marker or Green Marker) in the [Markers/Eraser] Toolbar.
  ● The shape of the mouse cursor changes to [Marker].

(3) Position the mouse where you want to draw a handwritten line on the page and drag the mouse.

(4) To erase handwritten lines, click [Eraser] in the [Markers/Eraser] Toolbar.
  ● The shape of the mouse cursor changes to [Eraser].

(5) Drag the mouse to the area on the page you want to erase.

Remark:
  ● To return to the state before the changes, click [Undo] in the [Edit] menu.
  ● The width and color of the markers and the size of the eraser can be changed.

● Undo

You can return handwritten lines drawn using the marker or erased using the eraser to their original state, stroke by stroke.

(1) Click [Undo] in the [Edit] menu.
  ● To return to the previous state, click [Undo] again.

Remark:
  ● To perform the operation that was undone once again, click [Redo] in the [Edit] menu.
  ● The [Undo] / [Redo] can be used over and over however if the page changes, the [Undo] / [Redo] may reset.
View Window or Whiteboard Window Operation

- **Add a new page to the IPB document (Whiteboard window only)**
  In the Whiteboard mode, add a new page next to the last page of the IPB document.
  When advancing the screen of the Interactive Panaboard during a meeting, add a new page.
     - A new page will be added next to the last page of the IPB document and the display switched to that page.

  **Remark:**
  - A maximum of 50 pages can be recorded. This software cannot add more than 50 pages.

- **Add a copy of the currently displayed page to the IPB document (Whiteboard window only)**
  In the Whiteboard mode, add a copy of the page currently displayed in main view next to the last page of the IPB document.
  Use this to leave the current contents on the screen of the Interactive Panaboard unchanged while adding new changes.
     - A copy of the currently displayed page will be added next to the last page of the IPB document and the display switched to that page.

  **Remark:**
  - A maximum of 50 pages can be recorded. This software cannot add more than 50 pages.

- **Delete currently displayed page**
  1. Display the page you want to delete in the main view.
     - A dialog box will be displayed asking you to confirm the delete.
  3. Click the [OK] button to delete.

  **Note**
  - Use caution because deleted pages cannot be recovered to their original state by [Undo] in the [Edit] menu.

- **Select page**
  2. Diagonally drag the mouse over the portion of the page you want to select.
     - The selected area will be displayed in reverse.
     - To select the entire page, click [Select All] in the [Edit] menu.
       The entire page will be displayed in reverse.

  **Remark:**
  - To cancel the selected state, click outside of the selected area.
Copy selected page range to clipboard

(1) Click (Arrow) in the [Markers/Eraser] Toolbar and drag the mouse to select the portion of the page you want to copy.
In addition, to select the entire page, click [Select All] in the [Edit] menu.
- The selected area will be displayed in reverse.

(2) Click [Copy] in the [Edit] menu.

Remark:
- To cancel the selected state, click outside of the selected area.
- The Image copied to the clipboard can be pasted in other applications.
- The Image copied to the clipboard becomes BMP image.

Copy selected page range to other application by dragging and dropping
You can copy data to other applications by dragging and dropping the selected page area. To perform this operation, the application copied to must support OLE (Object Linking and Embedding).

(1) Open the file where the data will be copied to and adjust the position of the application window such that the page to be copied and the file to be copied to are displayed in the screen. Arrange the documents such that both the information to be dragged and the position where that information will be dropped are displayed.

(2) Click (Arrow) in the [Markers/Eraser] Toolbar and drag the mouse to select the portion of the page you want to copy.
In addition, to select the entire page, click [Select All] in the [Edit] menu.
- The selected area will be displayed in reverse.

(3) Drag the selected area to the copy destination of the other application.

Remark:
- To cancel the selected state, click outside of the selected area.
- The file formats when copying by dragging and dropping can be selected from the formats below.
  Bitmap Files (*.bmp), TIFF Files (*.tif) or JPEG Files (*.jpg)
View Window or Whiteboard Window Operation

■ Playback the IPB document

The operations of drawing and erasing handwritten lines on each page are automatically recorded in stroke units and the locations of the drawing can be played back and confirmed later.

1. Click (Start) in the [Page/Play] Toolbar.

   - In the case of All Pages playback, the playback will start from the original state of the first page. In the case of Selected Page playback, the displayed page contents will return to their original state and the playback will start.
   - To stop the playback in the middle, click (Pause) in the [Page/Play] Toolbar. To restart the playback in the middle, click (Start) in the [Page/Play] Toolbar.
   - While stopping temporarily, you can move the Play Scroll bar in the [Page/Play] Toolbar to playback manually.
   - To end the playback in the middle, click (Stop) in the [Page/Play] Toolbar.
   - Playback is complete when the scroll bar reaches the far right end and stops.

**Remark:**
- You can click the arrows at the right and left of the Play Scroll bar or drag the Play Scroll bar to the right or left to playback the drawing.
- While playing back, you cannot use the marker and eraser in the [Markers/Eraser] Toolbar. In addition, in Whiteboard mode drawing on the screen of the Interactive Panaboard will not be reproduced either.
- You can change the playback conditions such as the playback interval, playback page and the playback loop. (See page 69.)
- You can also change the settings of the playback page and the playback loop from [Playback Option] in the [Page/Play] menu.

■ Recognizing Handwriting in the IPB document

- Recognizing Handwriting

  1. Click [Handwriting Recognition...] in the [Edit] menu.
     - The Handwriting Recognition dialog box will appear.
   2. Select the Recognition Range and click [OK].
     - The recognition results will be output as text to the Text Editor.

**Remark:**
- If [Delete the existing text] is checked (turned ON), the existing text will be deleted before the recognition results are output.
- English or German handwriting is the only language that can be recognized. Handwriting recognition for German will be available only when German is selected in "Regional Setting" of the Windows "Control Panel".
- The Text Editor displays the recognition results for the current page only. If [All Pages] is selected, switching to a certain page will display its recognition results.
- To specify text for recognition using the mouse, click (Arrow) in the [Marker/Eraser] Toolbar, drag the cursor over the text for recognition, and click the menu to perform recognition only on handwriting in the selected area.
- When the text cursor is aligned with the recognized text, the minimal shape of the handwritten line that forms the basis for the recognition will be indicated with dotted lines.
- Click (Arrow) in the [Marker/Eraser] Toolbar, then click the handwritten line that was recognized on the page to display the minimal shape of the handwritten lines and select the recognized text as a range.
- Cutting or deleting the recognized text dissociates it from the handwritten lines.
- When All Pages are subject to recognition, selecting [Undo] from the [Edit] menu cannot restore the file to the previous state.
View Window or Whiteboard Window Operation

● Replacing Possibly Misspelled Words with Alternatives
   (1) Click inside the Text Editor window.
   (2) Right-click on a word that might be misspelled.
      ● A pop-up menu will display alternatives.
   (3) Select the alternative word from the menu.
      ● The text will be replaced with the menu selection.

Remark:
● Wavy underlining for possibly misspelled words can be displayed or cancelled in the settings for [Spell Check...] in the [Settings] menu. (See page 72.)
● A maximum of five alternatives will be displayed.
● No alternatives will be displayed in the pop-up menu when there are no alternatives.
● Alternatives will only displayed for text that is produced after handwriting recognition.

● Undoing Actions
   (1) Click inside the Text Editor window.
   (2) Click [Undo] in the [Edit] menu.

Remark:
● To repeat the action performed before it was undone, click [Redo] in the [Edit] menu.
● [Undo/Redo] can be performed up to 100 times, but the counter is reset after switching pages.

● Copying Text
   (1) Click inside the Text Editor window.
   (2) Select the target text.
   (3) Click [Copy] in the [Edit] menu.
      ● The text will be copied to the clipboard.
      ● Selected text can be removed and copied to the clipboard by clicking [Cut] in the [Edit] menu.

Remark:
● Text copied to the clipboard can be pasted into other applications.

● Copying Text from All Pages to the Clipboard
   (1) Click inside the Text Editor window.
   (2) Click [Copy All Pages] in the [Edit] menu.
      ● The text in all pages will be copied to the clipboard.

Remark:
● Text copied to the clipboard can be pasted into other applications.

● Pasting Text
   (1) Click inside the Text Editor window.
   (2) Move the text cursor to the point of insertion.
   (3) Click [Paste] in the [Edit] menu.
      ● The clipboard text will be inserted to the point of insertion.
View Window or Whiteboard Window Operation

● Deleting Text
(1) Click inside the Text Editor window.
(2) Select the target text.
(3) Click [Delete] in the [Edit] menu.
   ● The text will be deleted.

Remark:
● The deleted text will not be copied to the clipboard.
● When recognized text is deleted, it is dissociated from the source handwritten lines. (See page 66.)

● Selecting All Text on a Page
(1) Click inside the Text Editor window.
(2) Click [Select All] in the [Edit] menu.
   ● All text in the current page will be selected.

Remark:
● To deselect, click inside the Text Editor window.

Print the IPB document

● Confirm print image of the IPB document before printing
(1) Click [Print Preview] in the [File] menu.
   ● Switch to the Print Preview screen.

(2) Click the [Close] button to exit the Print Preview and return the display mode to the original state.

Remark:
● The screen display mode that displays an image of the file when it is printed is called the Print Preview. In the Print Preview you can display print images of multiple page at a time. You can also expand or reduce the size of the page displayed in the screen.

● Print currently displayed IPB document
(1) Click [Print] in the [File] menu.
   ● The Print dialog box will appear.

(2) Set the [Printer], [Print range] and [Number of copies].

(3) Click the [OK] button.
   ● The Printing dialog box will appear.
   ● To stop the printing, click the [Cancel] button in the Printing dialog box.
Setting meeting information

Set meeting information recorded in the IPB document. Information that can be saved includes titles, subjects and descriptions, participants and related contact information.

Setting the information of a meeting will also allow you to output page images when exporting the IPB documents to HTML files.

(1) Click [Information...] in the [Settings] menu.

The Information dialog box will appear.

(2) Enter necessary information as follows, and then click the [OK] button.

**[Summary]** Enter a summary of the recorded meeting here.

- **Title:** Enter the title of the meeting.
- **Participants:** Enter the participants of the meeting.
- **Company:** Enter the name of the company.
- **Manager:** Enter the individuals responsible for the contents of the meeting.
- **Create On:** Automatically displays the date and time the IPB document was created.
- **Modified On:** Automatically displays the date and time the IPB document was updated finally.
- **Subject:** Enter the subject of the meeting.
- **Description:** Enter a description of the contents of the meeting.

**[Contacts]** Enter information to contract individuals for questions concerning the meeting here.

- **Name:** Enter the names of the person in charge of the meeting.
- **e-mail:** Enter the e-mail address of the person in charge of the meeting.
- **Home page:** Enter the home page of the person in charge of the meeting.

Set the conditions when playing back the IPB document

(1) Click [Play...] in the [Settings] menu.

The Playback Setting dialog box will appear.

(2) Enter an interval for playing back the stroke in the Interval time between strokes.

You can click the arrows at the right and left of the scroll bar or drag the scroll bar to the right or left to set a desired interval.

To play back currently displayed page only, add a check mark (turn ON) to the [Selected Page] check box.

To play back continuously, add a check mark (turn ON) to the [Loop Playback] check box.

**Remark:**

- The playback interval can be set in a range of 0 - 2 seconds in 1 msec (millisecond = 1/1000 second) units.
- When the [Selected Page] check box is ON, only the displayed page is played back.
- When OFF, the first page through the last page are played back.
- When the [Loop Playback] check box is ON, the first page through the last page are played back repeatedly after the last page is played back.
- When the [Selected Page] is also ON, the currently displayed page is played back repeatedly.
- The [Selected Page] and [Loop Playback] settings can be changed from [Playback Option] in the [Page/Play] menu.
Set the marker width, color or the eraser size
Change the width and color of the markers and the size of the eraser used in the View window or the Whiteboard window.
The marker width and color can be changed for four marker colors.
(1) Click [Markers and Eraser...] in the [Settings] menu.

The Marker/Eraser Setting dialog box will appear.
(2) To change the width of the markers, either enter a width in 3 4 dots (Marker Width) at the right side of the marker whose width will be changed or click the arrows at the right and left of the scroll bar or drag the scroll bar to the right or left to set a desired width.
To change the color of the markers, click (Marker Color) on the right side of the marker whose color will be changed. The Color dialog box will appear. Click the color you want to change from among Basic colors, and click the [OK] button.
To set a highlight marker, check (turn ON) the [Highlight] check box.
To change the size of the eraser, either enter a size in 10 dots (Eraser Radius) or click the arrows at the right and left of the scroll bar or drag the scroll bar to the right or left to set a desired size.
(3) Click the [OK] button.
(4) A dialog box will appear where you can select whether or not to apply the new settings to handwritten lines drawn up to now.
Clicking [Yes] button will redraw the lines drawn up to that point using the new settings.
Clicking [No] button will only reflect the new settings for any subsequently drawn lines.

Remark:
The unit of the marker width and the eraser size is dots in the View window and millimeters or inches in the Whiteboard window.
When you check (turn ON) the [Same Width] check box, you can set all markers to the same width by only setting the width of the black marker.
The marker width can be set in a range of 1 - 30 dots in the View window and 0.1 - 25.4 mm (0.01 - 1 inch) in the Whiteboard window.
When the marker color is changed, the color will be displayed on the bottom-right of the Desktop Drawing Tool marker button, but the marker tool color will not change.
When a highlight marker is set, the background under the drawn lines is transparent. In case that the background is dark and the drawn lines are hard to see, please turn the [Highlight] check box OFF. And when the line crosses with one of the different color, the part of that becomes dark.
The eraser radius can be set in a range of 1 - 60 dots in the View window and 0.1 - 50.8 mm (0.01 - 2 inch) in the Whiteboard window.
These settings are effective until being changed.
View Window or Whiteboard Window Operation

- Set an image file when exporting or copying by dragging and dropping
  
  Set the size when exporting a page to an image file and the file format to create when copying data to other applications by dragging and dropping a selected page area.

  (1) Click [Export Image...] in the [Settings] menu.

  ● The Export Image Settings dialog box will appear.

  (2) The following items can be set.

  [Export Image Files] group
  
  Image Size: To change the size when saving a page as an image file, enter a desired width and height. Check (turn ON) the [Constrain Proportions] check box when setting the aspect ratio of the page to an identical value even if the page dimensions change while saving it as the image file.

  JPEG: To set the quality level when exporting a page as a JPEG format image file.

  TIFF: To perform compression when exporting a page as a TIFF format image file, check (turn ON) the [Compression (PACKBITS)] check box.

  [Drag and Drop Files] group
  
  Set the file format to create when copying data to other applications by dragging and dropping a selected page area.

  The following file formats can be selected.
  
  WindowsBMP (*.bmp), JPEG (*.jpg) or TIFF (*.tif)

  If JPEG is selected, you can enter a quality level in [Quality:].

  If TIFF is selected, you can set Compression/No-compression using the [Compression (PACKBITS)] check box. Turn the check box ON for compression.

  (3) Click the [OK] button.

  Remark:

  ● The default of the width is 800 dots and the [Constrain Proportions] check box is checked (ON). The height will be different depending on the size of the Panaboard screen and the screen resolution of the PC where the projector is projecting the image.

- Set a work folder and the recovery file

  Set the default folder when opening or saving an IPB document. In addition, if settings are made to automatically create a recovery file, previously saved IPB documents can be recovered if a power failure or other incident occurs.

  (1) Click [File...] in the [Settings] menu.

  ● The File Settings dialog box will appear.
View Window or Whiteboard Window Operation

(2) The following items can be set.

- **Save Default Folder:** Set the path of the folder you want to display as a default when saving a new IPB document.
- **Create Recovery File:** To create a recovery file, add a check mark (turn ON).
- **Recovery File Folder:** To save the recovery file at the same folder as the original file, add a check mark (turn ON) to the [Same folder as original file] check box. Otherwise, set the directory to save the recovery file.
- **Save automatically every x minutes:** To set the automatic save interval of the recovery file in a range of 1 - 120 minutes.

(3) Click the [OK] button.

**Spell check setting for recognized handwriting**
Set the spell check for recognized handwriting.

(1) Click [Spell Check...] in the [Settings] menu.  
* The Spell Check Setting dialog box will appear.

(2) The following items can be set.

- **Display possibly misspelled words with wavy underlining:** When checked, possibly misspelled words are displayed with wavy underlining.

(3) Click the [OK] button.

**Remark:**
* Only text that is produced after handwriting recognition is subject to spell checking.

**Option setting**
Set the display method of the file name in the Title bar and the display unit system.

(1) Click [Options...] in the [Settings] menu.  
* The Options dialog box will appear.

(2) The following items can be set.

- **Display full path in Title bar:** To display the full path of the currently opened file in the title bar of the View window or the Whiteboard window, add a check mark (turn ON).
- **Measurement:** To switch the display unit system of the Whiteboard window.

(3) Click the [OK] button.

**Remark:**
* The computer screen will be projected onto the screen of the Interactive Panaboard in the Projector mode and because there is no physical size, the display unit system is only in pixels (dots) and cannot be changed.
* The display unit systems of millimeters / inches are used as units to represent the page size on the status bar, pen width and eraser size.
Remote Conferencing using Microsoft® NetMeeting®

About NetMeeting®

Microsoft® NetMeeting® is a software to share information with the computer connected in the network. When the Interactive Panaboard is connected with the computer connected in the network and NetMeeting® is used, it is possible to confer on the remote place using the Projector mode or the Whiteboard mode of the Interactive Panaboard Software.

It is necessary to install NetMeeting® in each computer which confers on the remote place. We recommend using NetMeeting® 3.0 or later. You are able to download latest NetMeeting® from the Microsoft® Corporation NetMeeting® Home Page of the Internet. (http://www.microsoft.com/windows/NetMeeting/)

This section explains an example of the remote conferencing using NetMeeting®.
For detailed explanation concerning NetMeeting®, please refer to help of NetMeeting® or the Microsoft® Corporation NetMeeting® Home Page of the Internet.

Example of using NetMeeting®

1. Connect the Interactive Panaboard with the computer which sponsors the remote conferencing, and run the Interactive Panaboard Software with the Projector mode or the Whiteboard mode.

2. Run NetMeeting® with all computers which confer on the remote place.

3. Call the computer which participates from the computer which sponsors the remote conferencing.
   - To call, select from the user who connects the computer with the Internet directory server or input IP address directly.

4. Receive the call with the computer which participates in the remote conferencing.

5. Share a program of the computer which sponsors the remote conferencing.
   - When you use the program sharing feature, other people can see the program.
   - When the Projector mode is used, share the Desktop.
   - When the Whiteboard mode is used, share the Whiteboard window of the Interactive Panaboard Software.
   - When you allow control, other people can both see and use the program. It is only one person at a time to be able to control the shared program.

6. Confer on the remote place using the shared program.

7. When the remote conferencing finishes, stop sharing a program and exit NetMeeting®.
Remote Conferencing using Microsoft® NetMeeting®

Note

- You cannot call people on the Internet that you have located on Web-based directory servers if your Internet connection uses a proxy server that does not support NetMeeting®.
- When you share a program and decide to allow someone to control it, remote users can use the File Open and File Save dialog boxes in your program to gain access to or delete files on your computer or network. It is recommended that you do not leave your computer unattended while sharing a program and allowing control.
- You can connect to only one other person with audio and/or video at a time.
Daily Care and Maintenance

Always turn off the power switch and unplug the power plug when cleaning outside and inside the unit.

Cleaning the screen and the unit
Gently wipe the screen film and unit with a water-dampened cloth that has been thoroughly wrung.

- Use a commercially available white board cleaner for hard-to-clean stains. (SANFORD® EXPO® white board cleaner etc.)
- If you accidentally write on the board with an oil-based marker, wipe with a small amount of ethyl alcohol.

Note
- Do not use thinner, benzine or cleaners containing abrasives as this may result in discoloration.
- Do not wipe the screen film with a dry cloth as this may generate a static charge.

Caring for the eraser
When the erasing surface of the eraser becomes dirty, hold down the sheet under the top sheet with your finger and peel off the dirty sheet by pulling in the direction of the arrow.

Note
- When the eraser becomes thin, make sure that the corners of the eraser do not strike the screen during erasing as this may damage the screen.

Cleaning the printer head, platen roller and feed roller
- If black streaks appear on the copy, clean the printer head and the platen roller.
- If paper jams occur frequently, clean the feed roller.

1 Push down the printer open lever and open the printer door.
Daily Care and Maintenance

Clean the Printer Head

2  Dampen the tip of a cotton swab in ethyl alcohol and gently wipe the printer head.

Note
- Never touch the printer head or the surrounding area with your hands as this may disable copying.

Clean the Platen Roller and the Feed Roller

3  Remove the film cassette with both hands and carefully wipe any dirt or stains off the platen roller and feed roller.
- For details on removing the film cassette, see page 20.
- Dampen a soft cloth with neutral kitchen cleaner diluted in water, wring the cloth thoroughly, and wipe the entire surface of the rollers while rotating them. If this does not remove all dirt, wipe with a cloth dampened with ethyl alcohol.

4  Attach the film cassette in its original position and close the printer door.
- For details on attaching the film cassette, see page 14.
- Close the printer door firmly until a click is heard.

Note
- If "E" is displayed on the multi-copy/error indicator when the power is turned on, this indicates that the film cassette has not been installed properly or that there is slack in the thermal transfer film. Check the condition of the film cassette and for slack in the thermal transfer film.
Replacing the Batteries in the Electronic Pen and the Electronic Eraser
As the lifetime of the batteries in the Electronic Pen or the Electronic Eraser comes near to the end, the message “Low Battery” appears on the PC screen to which the electronic print board is connected using interactive functions. When this message appears, get new batteries ready and replace the old ones as soon as possible.
When replacing batteries, remove the old batteries and replace according to step 1 under “Setting the Electronic Pen” on page 24 in the case of the Electronic Pen or according to “Setting the Electronic Eraser” on page 25 in the case of the Electronic Eraser. Continued use of low batteries may result in a shifting of position or malfunction.

Replacing the Cloth of the Electronic Eraser
If the cloth of the Electronic Eraser becomes dirty with erased markings, replace with a new eraser cloth according to “Replacing the eraser cloth” on page 25.

Troubleshooting
Treat problems according to the information given in the table below. If problems still persist, call your dealer for service.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Care and Remedy</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power switch is on but the indicator is off.</td>
<td>Check that the power plug is securely plugged in. (If the indicator still does not light, turn the power off and on again.)</td>
<td></td>
</tr>
<tr>
<td>Copied copy paper will not come out.</td>
<td>The unit is out of copy paper or thermal transfer film. (Error indicator flashes &quot; &quot; or &quot; &quot;.) $\Rightarrow$ Insert copy paper or replace the thermal transfer film. The printer door is open. (Error indicator flashes &quot; &quot;) $\Rightarrow$ Close the printer door firmly until a click is heard. Paper is jammed in the printer. (Error indicator flashes &quot; &quot;) $\Rightarrow$ Open the printer door and remove the jammed paper. The platen roller and feed roller are dirty. $\Rightarrow$ Open the printer door and clean the platen roller and the feed roller.</td>
<td>16 20 15 21 75</td>
</tr>
<tr>
<td>Nothing is printed on the paper or copies are faint or blurred.</td>
<td>$\bullet$ The markers for interactive (Small) are used. $\Rightarrow$ Use the markers (Big). $\bullet$ The writing on the screen is too thin or light. $\Rightarrow$ Make thicker, darker lines or change to a new marker. The printer door is slightly open. $\Rightarrow$ Close the printer door firmly until a click is heard.</td>
<td>15</td>
</tr>
<tr>
<td>Black streaks or blank (unprinted) spots appear on the copy (copy paper is dirty).</td>
<td>The printer head or platen roller is dirty. $\Rightarrow$ Open the printer door and clean any dirt off the printer head and platen roller. The room temperature is 10°C (50°F) or lower. $\Rightarrow$ Increase the room temperature, turn the unit’s power off and on, and retry copying. The thermal transfer film is wrinkled because it was set in place without removing excess slack. $\Rightarrow$ Rewind the used portion of the thermal transfer film to remove the excess slack, then reattach it.</td>
<td>75 15 21</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Care and Remedy</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The screen does not advance when the COPY or ADVANCE keys are pressed.</td>
<td>Static electricity was generated when the screen film was wiped.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>➡️ Turn off the power and slowly move the screen by hand.</td>
<td></td>
</tr>
<tr>
<td>Contrast/Remaining film indicator flashes.</td>
<td>The time to replace the thermal transfer film is approaching. (Only about 15 more copies can be made.)</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>➡️ Prepare a new replacement film (KX-BP081 or KX-BP082).</td>
<td></td>
</tr>
<tr>
<td>The computer can not recognize the electronic print board when the interactive function is used.</td>
<td>Check that the interactive cable is securely connected.</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>Communication port setting is not appropriate.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>➡️ Change communication port setting according to “COM port” on page 31.</td>
<td>31</td>
</tr>
<tr>
<td>The Electronic Pen position may shift when the Projector mode is used.</td>
<td>The projection position shifts.</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>➡️ Calibrate to reposition the projected image on the screen.</td>
<td></td>
</tr>
<tr>
<td>Data written on the electronic print board may disappear from the electronic print board screen and the computer screen or its position may shift when the interactive function is used.</td>
<td>• Use the Electronic Pen inclined at an angle.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Direct sunlight or strong light is striking the screen.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• A remote controller is being aimed at the receiver on the electronic print board.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The side of the electronic print board is placed near the wall, or the top of the electronic print board is placed near the ceiling.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The electronic print board is placed near the vents of an air conditioner.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The receiver of the electronic print board is blocked by a hand or other object.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The transmitter of the Electronic Pen or the Electronic Eraser is covered with your hand.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Two or more the Electronic Pens or the Electronic Eraser are used at the same time.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If the position shifts for reasons other than the above, adjust the position according to “Adjustment” on page 31.</td>
<td></td>
</tr>
<tr>
<td>Unnecessary streaks not written are displayed on the computer screen when the interactive function is used.</td>
<td>Do not do the followings near the electronic print board while using the interactive function.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Exchanging markers for interactive (Small) of the Electronic Pen</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Setting or removing a marker cap of the Electronic Pen</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Pushing the point of the Electronic Pen</td>
<td></td>
</tr>
<tr>
<td>Detection of the marker color of the Electronic Pen does not work well when the Whiteboard mode of the interactive function is used.</td>
<td>The marker for interactive (Small) is not securely set.</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>➡️ Rotate the pen holder lever to the release potion, and then return the pen holder lever to the lock position while inserting the marker until you hear a buzzing sound.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The proprietary marker for interactive (Small) is not set into the pen holder.</td>
<td>81</td>
</tr>
<tr>
<td></td>
<td>➡️ Use the proprietary markers for interactive (Small).</td>
<td></td>
</tr>
<tr>
<td>The message “Low Battery” appears on the computer screen.</td>
<td>Replace batteries of the Electronic Pen or the Electronic Eraser which have “Low Battery” message displayed.</td>
<td>77</td>
</tr>
</tbody>
</table>
### Meanings of various displays

The following table describes the meaning of each of the symbols which may flash in the Multi-Copy/Error indicator.

<table>
<thead>
<tr>
<th>Indication</th>
<th>Cause</th>
<th>Remedy</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>P</td>
<td>Out of paper.</td>
<td>Load copy paper.</td>
<td>16</td>
</tr>
<tr>
<td>d</td>
<td>The printer door is not closed securely.</td>
<td>Close the printer door securely.</td>
<td>15</td>
</tr>
<tr>
<td>r</td>
<td>The thermal transfer film is slack or has run out.</td>
<td>Remove the slack from the thermal transfer film or replace.</td>
<td>15</td>
</tr>
<tr>
<td>H</td>
<td>Paper jam.</td>
<td>Open the printer door and remove the jammed paper.</td>
<td>21</td>
</tr>
<tr>
<td>L</td>
<td>The screen will not move.</td>
<td>Remove any chart paper attached to the screen and slowly move the screen by hand.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>The room temperature is 10°C (50°F) or lower.</td>
<td>Increase the room temperature.</td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>The fluorescent lamp is dead.</td>
<td>Call your dealer for service.</td>
<td></td>
</tr>
</tbody>
</table>

*If other indications such as "H" appear, call your dealer.*
## Specifications

<table>
<thead>
<tr>
<th>Model Number</th>
<th>KX-BP800</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td>Power Supply</td>
<td>AC100 -120 V, 50/60 Hz</td>
</tr>
<tr>
<td>Power Consumption (Operational/Standby)</td>
<td>2.2 A/0.1 A</td>
</tr>
<tr>
<td>External Dimensions Height×Width×Depth</td>
<td>Without stand: 1,400×1,550×240 mm (4' 7 7/8&quot;×5' 1 1/2&quot;×9' 7/8&quot;)&lt;br&gt;With stand: 1,875×1,550×1,100 mm (6' 1 1/8&quot;×5' 1 1/2&quot;×3' 7/8&quot;)</td>
</tr>
<tr>
<td>Weight (without stand)</td>
<td>34.0 kg (75 lbs)</td>
</tr>
<tr>
<td>Ambient Operating Conditions</td>
<td>Interactive Function&lt;br&gt;Temperature: 15 - 30°C (59 - 86°F), Humidity: 30 - 80% R.H.&lt;br&gt;Other than Interactive Function&lt;br&gt;Temperature: 10 - 35°C (50 - 95°F), Humidity: 30 - 80% R.H.</td>
</tr>
<tr>
<td>Writing Implements</td>
<td>Dry erase felt-tipped markers (black, red, blue and green*)&lt;br&gt;*The green marker is only for the interactive function.</td>
</tr>
<tr>
<td><strong>Input Block</strong></td>
<td></td>
</tr>
<tr>
<td>Screen Size</td>
<td>1,651 mm (65&quot;) Diagonal</td>
</tr>
<tr>
<td>Panel Surfaces</td>
<td>2 (endless type)</td>
</tr>
<tr>
<td>Panel Advance System</td>
<td>Scroll type</td>
</tr>
<tr>
<td>Copying Area Height×Width</td>
<td>850×1,330 mm (2' 9 1/4&quot;×4' 4 1/4&quot;)</td>
</tr>
<tr>
<td>Scanning System</td>
<td>CCD flat-scan type</td>
</tr>
<tr>
<td>Printing System</td>
<td>Fusion thermal transfer type</td>
</tr>
<tr>
<td>Copy Paper</td>
<td>Standard or recycled paper [60 - 90g/m² (16-24 lbs)]</td>
</tr>
<tr>
<td>Copy Paper Size</td>
<td>Letter [216×279.4 mm (8 1/2&quot;×11&quot;)]</td>
</tr>
<tr>
<td>Copy Density</td>
<td>8 dots/mm (203 dots/inch)</td>
</tr>
<tr>
<td>Copy Color</td>
<td>Black</td>
</tr>
<tr>
<td>Contrast Adjustment</td>
<td>Two levels: Normal/Dark</td>
</tr>
<tr>
<td>2-Screen Compressed Copying</td>
<td>Yes</td>
</tr>
<tr>
<td>Time Required for Copying</td>
<td>15 sec./sheet</td>
</tr>
<tr>
<td>Continuous Copies</td>
<td>1 to 9 sheets</td>
</tr>
<tr>
<td>Out-of-Paper Indication</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Output Block</strong></td>
<td></td>
</tr>
<tr>
<td>Effective Area Height×Width</td>
<td>Projector mode: 850×1,330 mm (2' 9 1/4&quot;×4' 4 1/4&quot;)&lt;br&gt;*The position cannot be detected within 50 mm (2&quot;) of the upper screen border.&lt;br&gt;Whiteboard mode: 825×1,330 mm (2' 8 1/4&quot;×4' 4 1/4&quot;)&lt;br&gt;*The whiteboard cannot be written on within 50 mm (2&quot;) of the upper screen border and 25 mm (1&quot;) of the lower screen border.&lt;br&gt;*It is not always possible to normally detect the position within 100 mm (3 15/16&quot;) of the position receiver and 35 mm (1 3/8&quot;) from the both sides of the screen.</td>
</tr>
<tr>
<td>Interface</td>
<td>RS-232-C</td>
</tr>
<tr>
<td>Battery for Electronic Pen or Electronic Eraser</td>
<td>LR03 (&quot;AAA&quot; size) X2&lt;br&gt;*Alkaline battery</td>
</tr>
<tr>
<td>Battery Longevity for Electronic Pen or Electronic Eraser</td>
<td>48 hours [Continuously at 25°C (77°F)]&lt;br&gt;*When using Panasonic &quot;LR03&quot; (&quot;AAA&quot; size) alkaline batteries.</td>
</tr>
</tbody>
</table>

---

80
## Specifications

### Consumable and accessories

<table>
<thead>
<tr>
<th>Item</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wall-mounting Kit</td>
<td>KX-B063</td>
</tr>
<tr>
<td>Stand</td>
<td>KX-BP065</td>
</tr>
<tr>
<td>PC Interface Kit</td>
<td>KX-BP095 (for connection to PC)</td>
</tr>
</tbody>
</table>
| Replacement Film                    | KX-BP081 [contains two 100m (328.1') rolls]  
                                    | KX-BP082 [contains 100m (328.1') roll and film cassette] |
| Markers (Big) and Eraser Set        | KX-B035 (contains one black, one red, one blue marker,  
                                    and one eraser) |
| Pen Holder                          | KX-BP038 |
| Electronic Eraser                   | KX-BP048 |
| Marker (Small) set                  | KX-BP0385 (contains one black, one red, one blue and  
                                    one green marker) |
| Eraser Cloth (for Electronic Eraser)| KX-BP0481 (set of 10 cloths) |

* Ruler kit (KX-B05) can not be used with the interactive function.

* The markers (Big) and the eraser are used for other than the interactive function.

* The markers for interactive (Small) are used while inserted in the pen holder.

  The Electronic Pen [a marker for interactive (Small) inserted in the pen holder] and the Electronic Eraser are used with the interactive function.

* PC Interface (Option)

  When the optional PC Interface Kit (KX-BP095) is used, you can scan monochrome images from the KX-BP800 into a computer running Microsoft® Windows® or Windows NT® and print documents on the computer to the printer of the KX-BP800.
Table of contents

<table>
<thead>
<tr>
<th>Part name</th>
<th>Part illustration/quantity</th>
<th>Attachment procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power cord</td>
<td><img src="image" alt="Power cord" /></td>
<td>Page 85, Item 4.1</td>
</tr>
<tr>
<td>Wall mounting template (for wall mounting)</td>
<td><img src="image" alt="Wall mounting template" /></td>
<td>Page 92, Item 2</td>
</tr>
</tbody>
</table>

Accessories

The following accessories are required for assembly.

- **Power cord**: Page 85, Item 4.1
- **Wall mounting template (for wall mounting)**: Page 92, Item 2

All accessories included in the package are given on the next page. Make sure that all of these parts are included in the package before proceeding.

**WARNING**

DO NOT INSTALL THIS OPTION EXCEPT QUALIFIED SERVICE PERSONNEL.

**CAUTION**

SAFETY CHECK MUST BE DONE BY QUALIFIED SERVICE PERSONNEL AFTER INSTALLING THIS OPTION.
Assembling the Print Board

Assembly

1 Assembly of the optional stand or wall-mounting kit.

- If you are using a stand, refer to page 88.
- If you are using a wall-mounting kit, refer to page 91.

2 Remove the print board from the shipping box.

Remove the joints, then remove the print board from the shipping box.

![Diagram of assembly process]

- Film cassette ........................................... 1
- Blue gear ............................................. 1
- Green gears ......................................... 3
- Thermal transfer film [20m (65.6')] ............ 1
- Markers (Black, Red, Blue-Big) ................. Each 1
- Eraser .................................................. 1
- Letter papers ........................................ 20 sheets
- Pen holder .......................................... 2
- Markers for interactive
  (Black, Red, Blue, Green-Small) ............. Each 1
- Electronic eraser .................................. 1
- Eraser cloth (for electronic eraser) .......... 2
- Batteries (LR03 "AAA") ......................... 6
- Power cord ......................................... 1
- Interactive cable [5m (16.4')] ............... 1
- Software CD-ROM ................................. 1
- Operating Instructions ........................... 1
- Software License Agreement ................. 1
- Wall-mounting template ....................... 1
- Warranty card ................................... 1

Note

- Do not touch the screen film surface as doing so may damage it.
- The shipping box, cushioning material, and other packaging materials will be necessary if you ever need to repackage the print board, so do not throw them away.
3 Attach the print board.

- If you are using a stand:
  1. Hang the print board on the attachment fixtures of the stand.
  2. Use the two wing bolts (M5 12 mm) provided with the stand to fasten the print board to the lower stand attachment fixtures as shown below.

- If you are using a wall-mounting kit:
  1. Remove the two wing bolts and hang the print board on the wall-mounting fixtures supplied with the wall-mounting kit. (Please refer to page 92.)
  2. Use the two wing bolts removed in step 1 above to fasten the print board to the lower wall-mounting fixtures as shown below.

Note
- When mounting the print board, avoid banging it. Such impact may break the internal fluorescent light or cause other damage.
- After mounting the print board, gradually apply weight to it to make sure that the wall is strong enough to support it.

- The stand (KX-BP065) is available as an option.
- The wall-mounting kit (KX-B063) is available as an option.
Assembling the Print Board

4 **Attach the power cord.**

1. Securely fit the supplied power cord into the AC inlet on the printer unit.

2. Fit the power cord into the cord holder. Do not force it.

5 **Wipe the screen film surface.**

Wipe the screen film gently with a water-dampened cloth that has been thoroughly wrung.

6 **Check operations.**

Refer to page 86 "Print Board Operations Check".

**Note**

- Do not use thinner, benzine or cleaners containing abrasives as this may result in discoloration.
- Do not wipe the screen film with a dry cloth as this may generate a static charge.
## Print Board Operations Check

After assembling the print board, perform the procedures presented in the following table to make sure it functions properly.

### Normal print board operations check

<table>
<thead>
<tr>
<th>Step</th>
<th>Normal print board operations (points to check)</th>
<th>Multiple copy/ error display</th>
<th>Other points to check</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Turn on the power switch.</td>
<td>&quot; &quot; flashes after</td>
<td>___________</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot; &quot; lights up.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Open the printer door and attach the supplied</td>
<td>&quot; &quot; flashes.</td>
<td>___________</td>
</tr>
<tr>
<td></td>
<td>thermal transfer film, then close the printer door.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Installing Thermal Transfer Film procedure</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>(refer to page 14)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Open the paper cover and insert ordinary Letter</td>
<td>&quot; &quot; lights up.</td>
<td>___________</td>
</tr>
<tr>
<td></td>
<td>test paper, then close the paper cover.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Loading Copy Paper procedure</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>(refer to page 16)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Open the printer door.</td>
<td>&quot; &quot; flashes.</td>
<td>___________</td>
</tr>
<tr>
<td>5</td>
<td>Close the printer door.</td>
<td>&quot; &quot; lights up.</td>
<td>___________</td>
</tr>
<tr>
<td>6</td>
<td>Press [Left].</td>
<td></td>
<td>● Does the screen film surface feed smoothly?</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● Are there any strange noises?</td>
</tr>
<tr>
<td>7</td>
<td>① Use the supplied marker to draw a large</td>
<td>&quot; &quot; lights up.</td>
<td>● Are three copies made?</td>
</tr>
<tr>
<td></td>
<td>[N] filling the entire copyable area of the</td>
<td></td>
<td>● Is the entire readable area printed?</td>
</tr>
<tr>
<td></td>
<td>screen film surface.</td>
<td></td>
<td>● During the copying process, are there any strange noises or paper jams? Are multiple sheets of paper fed through at the same time?</td>
</tr>
<tr>
<td></td>
<td>● Copyable area (refer to page 9)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>② Press [P] twice. (will add to 3 copies)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● &quot; &quot; will be displayed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>③ Press [P].</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>① Press [Left] to move the screen film surface.</td>
<td></td>
<td>● Has the darkness indicator light turned on?</td>
</tr>
<tr>
<td></td>
<td>Write letters, etc. with the marker.</td>
<td></td>
<td>● Is the image copied properly?</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● Are there strange markings on the copy sheet (e.g., stripes or lines)?</td>
</tr>
<tr>
<td></td>
<td>② Press [Left] once.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>③ Press [P].</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Press [Left] once.</td>
<td></td>
<td>Has the darkness indicator light turned off?</td>
</tr>
<tr>
<td>10</td>
<td>Press [Left].</td>
<td></td>
<td>Are two screens copied properly?</td>
</tr>
</tbody>
</table>

● If the unit fails on any of the check points, please contact your dealer.
Interactive operations check

1. Connect the print board to the PC according to the instructions of page 26 using the supplied interactive cable.

2. Install the software on the PC according to the instructions of page 27 and check that the interactive function operates.
   *
   If the Electronic Pen position shifts, adjust the position according to the instructions of page 31.

Repacking

Perform assembly steps 2 through 4 (refer to pages 83 through 85) in reverse to repack the print board and accessories. Use the joints to fasten the shipping box to the upper and lower box.

- Refer to the shipping box instructions for information on how to fasten the 16 joints.
Assembling the Optional Stand (KX-BP065)

**Accessories**

The package box for the optional stand includes the parts noted below; please confirm that all parts are present before beginning installation.

<table>
<thead>
<tr>
<th>No.</th>
<th>Part name</th>
<th>Part illustration</th>
<th>Q'ty</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Stand base</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>Pipe</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>Cover</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>4</td>
<td>Side bar A</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>5</td>
<td>Side bar B</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>Screw</td>
<td>M8×45mm (1\textfrac{5}{16}&quot;&quot;)</td>
<td>12</td>
</tr>
<tr>
<td>7</td>
<td>Fixture (left)</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>8</td>
<td>Fixture (right)</td>
<td></td>
<td>2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No.</th>
<th>Part name</th>
<th>Part illustration</th>
<th>Q'ty</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>Wing bolt</td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>10</td>
<td>Support bracket</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>11</td>
<td>Fall-prevention extension leg</td>
<td></td>
<td>4</td>
</tr>
<tr>
<td>12</td>
<td>Screw</td>
<td>M6×60mm (2\textfrac{1}{2}&quot;&quot;)</td>
<td>4</td>
</tr>
<tr>
<td>13</td>
<td>Nut</td>
<td></td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Wrench</td>
<td>*1</td>
<td>1</td>
</tr>
</tbody>
</table>

*1 The accessory wrench is required when disassembling the electronic print board; please store it carefully for future use.

**Before assembly, be sure to lock the casters.**

[Diagram of locking and releasing casters]
**Assembly**

1. **Assembling the stand**

- **Assembling the fall-prevention extension legs.**
  - The fall-prevention extension legs increases the safety of the electronic print board.
  - Do not tighten the screw *6* too much. This may deform the pipes.

- Insert the covers *3* to the pipes *2*.

- Caster locks are attached to the back side.

- To lock the fall-prevention extension legs, lift portion *A*.

- Assemble with the holes toward the front.

- Locking casters side. (rear)
Assembling the Optional Stand (KX-BP065)

2  Attach the attachment fixtures 7 8 with the four wing-bolts.

3  Assemble and install the print board.

⇒ Please refer to assembly instructions on page 84.
Wall-mounting Kit (KX-B063)

Before attempting installation of this wall-mounting kit, we strongly recommend consulting with the building facility manager, engineer or architect. The installer needs to know the type of construction used for the wall intended for this installation and the location of wall studs. Selection of hardware is critical for safe wall-mounting, and dependent upon the nature of wall construction, installation should not occur until this consultation takes place.

Procedure for KX-B063 Wall-mounting Kit Installation

I. Tools required:
- One (1) KX-B063 kit
- A minimum of eight (8) pieces of appropriate wall-support hardware (molley, toggle, etc.)
- Drill (and drill bit of correct size) for hardware installation
- Screw driver (Both phillips (+) and slotted (-) will be required.)
- Tape measure
- Tape or thumb-tacks (2pcs)
- Bubble type level

II. Pre-requisites
1. Before installation, make sure that the wall intended for installation is capable of supporting flush-mounted. ([ KX-BP800 is 103 kgf (227 lbs). ])
2. The position of the intended installation is of adequate size for the selected Panaboard. ([ KX-BP800 is 1,575 mm X 1,524 mm (5’2” X 5’). ])
3. An outlet is within 3 m (9’10” 4/32”), and it is not located directly behind the Panaboard.

- Accessories
  The package includes the parts noted below; please confirm that all parts are present before beginning installation.
  Eight screws for mounting the fixtures on the wall are not provided. Please purchase the appropriate wall-mounting hardware (sold in stores). Refer to pages 93 and 94.

<table>
<thead>
<tr>
<th>No.</th>
<th>Part name</th>
<th>Part illustration, Q’ty</th>
<th>Order of use</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Wall-mounting fixture L</td>
<td>![Part Illustration]</td>
<td>3</td>
</tr>
<tr>
<td>2</td>
<td>Wall-mounting fixture R</td>
<td>![Part Illustration]</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>Wing bolt</td>
<td>![Part Illustration]</td>
<td>—</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No.</th>
<th>Part name</th>
<th>Part illustration, Q’ty</th>
<th>Order of use</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Screw</td>
<td>![Part Illustration]</td>
<td>—</td>
</tr>
<tr>
<td>5</td>
<td>Wall-mounting template</td>
<td>![Part Illustration]</td>
<td>2</td>
</tr>
</tbody>
</table>

* These are used for other models.
Wall-mounting Kit (KX-B063)

Wall-mounting procedure

1 Confirm that the wall is strong enough to support the weight of the print board. (Please refer to page 91.)

Caution:
The wall must be capable of supporting at least 1,005N [103 kgf (227 lbs)] for KX-BP800.

2 Tape the wall-mounting template to the wall.
   • Do not use the template included in the wall-mounting kit (KX-B063), but rather the one included with the electronic print board (KX-BP800).
   • When taping the template to the wall, make sure it is level.

3 1. Drill holes in the wall for the wall-mounting fixtures. (8 holes total)
   2. After removing the wall-mounting template, attach the wall-mounting fixtures with the appropriate wall-mounting hardware (two screws in each fixture).

*This hardware must be locally procured, it is not included in the kit.
• Refer to the section “Attaching the wall-mounting fixtures” (pages 93 and 94) for drilling in the wall and attaching the mounting fixtures.

Mount the print board. (Please refer to page 84.)
- Attaching the wall-mounting fixtures
  The electronic print board must be mounted with the method most suited to the material of the wall. Three methods are presented here. (Other options may be available in your area.)

  - Attaching to metal or concrete walls
    Stud plugs (sold in stores) are needed.

Drill eight holes in the wall. For the correct hole size, refer to the instructions for the particular stud plugs used.

Insert a stud plug in each hole.

Insert each bolt through a hole in the wall-mounting fixture and tighten until the wall-mounting fixture is securely fixed to the wall.
Wall-mounting Kit (KX-B063)

**• Attaching to plasterboard walls**

Split-wing toggles (sold in stores) are needed.

Insert each bolt through a hole in the wall-mounting fixture and into the hole in the wall beneath so that the arms of the split-wing toggle are horizontal. For the correct hole size, refer to the instructions for the particular split-wing toggles used.

After the arms expand, pull the wall-mounting fixture out until the arms of the split-wing toggle grip firmly into the wall.

Tighten each bolt until the wall-mounting fixture is securely fixed to the wall.

**• Attaching to wooden walls**

Use wood screws (sold in stores).

For the correct hole size, refer to the instructions for the particular wood screws used.